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Course Overview    
̙̤̅̚ ̠̦̣̤̖̔ ̨̝̝̚ ̧̠̖̣̔ ̨̙̠ ̥̠ ̣ ̖̗̖̣̖̟̖̔ ̠̝̖̣̕ ̧̦̣̖̪̄ ̘̟̕ ̗̝̖̤̚ ̣̖̥̖̔̒̕ ̟̚ ̇˩̚ ̤̒ ̨̖̝̝ ̤̒ ̨̟̖ 
˴̀˿˿˶˴̅ ˶̥̠̟̕̚̚ ̧̤̦̣̖̪ ̗ ̝̖̤̚˟  ̙̖̅ ̠̦̣̤̖̔ ̨̝̝̚ ̝̤̠̒ ̥̖̙̒̔ ̗̗̖̣̖̟̥̕̚ ̥ ̢̖̙̟̦̖̤̔̚ ̥ ̠ ̥̥̙̒̒̔ ˺̞̘̖̣̪̒ 
̟̒̕ ˽̚ ˵˲ ̃̕ ̥̒̒˟  The CTDOTЯ̤  default Geographic Coordinate System (GCS) is NAD 1983 State 
Plane Connecticut with a North American Vertical Datum of 1988. There are cases in which the 
Survey was created using different datums , this course will step th rough the process of 
reprojecting  imported data to line up with other datums.  
 
In this course you will also be displaying and annotating the features of an existing terrain model 
using the properties and terrain tools. You will learn how to work directly in both a 3D terrain model 
file, and in a 2D referenced file, to display features using default standards, an d how to  
modify the default parameters to change the display. You will also learn how to display a 
background map and label elevations.  

̜̝̝̤̄̚ ̦̘̙̥̅̒ 
¶ ̖̗̖̣̖̟̟̘̃̔̚ ˙̠̝̖̣̕ ̧̦̣̖̪̄ ̘̟̕ ̗̝̖̤̚ ̣̖̥̖̔̒̕ ̟̚ ̇˩̚ ̤̒ ̨̖̝̝ ̤̒ ̨̟̖˚ 
¶ ̟̖̣̤̥̟̟̘̆̒̕̕̚ ˸̡̖̠̘̣̙̒̔̚ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̤̄ 
¶ ˴̣̖̥̟̘̒̚ ̤̥̖̣̃̒ ˴̠̟̥̟̖̣̒̚ ˷̝̖̚ ̤
¶ ˲̥̥̙̟̘̒̔̚ ˺̞̘̖̣̪̒ 
¶ ˺̡̞̠̣̥̟̘̚ ˽̚˵˲̃ ˵̥̒̒ 
¶ ̤̟̘̆̚ ̟̒̕ ̣̖̥̟̘̔̒̚ ̖̣̣̟̤̅̒̚ 
¶ ̖̃˞̡ ̛̣̠̖̥̟̔̚ ̘˵ ˸˿ ̗̝̖̚ ̤
¶ ˴̠̟̟̖̥̟̘̔̚ ̥̠ ˸˺̄ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

 ˥
 

˶̩̖̣̤̖̤̔̚ ̟̒̕ ˲̧̝̝̖̒̒̓̚ ̠̣̜̟̘̈̚ ˷̝̖̤̚ 
˶̩̖̣̤̖̔̚ ˢ Ь ̖̗̖̣̖̟̟̘̃̔̚ ̥̙̖ ̧̦̣̖̪̄ ˷̝̖̚ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡˢ˦˥˞l ˢˣ˩̖̤̥̣̠̠̜̐̈̓̐̀̃˵˟̘̟̕ 

˶̩̖̣̤̖̔̚ ˣ Ь ̖̗̖̣̖̟̟̘̃̔̚ ̝̀̕ ̇˩̚ ˷̝̖̤̚ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡˡ˪˩̐ˡˢˡˤ̐˳̣̟̗̠̣̒̐̕˸̃˿˟̘̟̕ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡˡ˪˩̐ˡˢˡˤ̐˳̣̟̗̠̣̒̐̀̃̕˵̖̣̣̟̐̅̒̚˟̘̟̕ 

˶̩̖̣̤̖̔̚ ˤ Ь ̠̣̜̟̘̈̚ ̨̥̙̚ ˵̥̦̞̤̒ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡˢˡ˨̐ˡˢˡ˩̩̗̠̣̐̀̐̕˸̃˿˟̘̟̕ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡˢˡ˨̐ˡˢˡ˩̩̗̠̣̐̀̐̀̃̕˵̖̣̣̟̐̅̒̚˟̘̟̕ 

˶̩̖̣̤̖̔̚ ˥ Ь ˲̥̥̙̟̘̒̔̚ ˺̞̘̖̣̪̒ 
з̍ ̙̣̖̄̒̍̀ ̨̩̗̠̣̍̕ ˟̤̚̕ 

˶̩̖̣̤̖̔̚ ˦ Ь ˴̣̖̥̟̘̒̚ ̒ ̖̣̣̟̅̒̚ ̗̣̠̞ ˽̚˵˲̃ ˵̥̒̒ 
з̍ ̙̣̖̄̒̍̀ ̨̩̗̠̣̍̕ ˟̝̤̒ 

˶̩̖̣̤̖̔̚  ˧Ь ̖̣̣̟̤̅̒̚ ̗̠̣ ˵̣̟̘̖̒̒̚ ˲̟̝̪̤̤̒̚ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̐˲̝̘̟̞̖̟̥̤̚˟̘̟̕ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̒̐˴̠̣̣̠̣̚̕˟̘̟̕ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̠̦̥̖̐̃ˢ˩˩̐˴̠̣̣̠̣̚̕˟̘̟̕ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̠̦̥̖̐̃ˢ˩˩̖̣̣̟̐̅̒̚˟̘̟̕ 
з̍ ˹̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̒̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̡̦̖̣̐̄˟̘̟̕ 
з̍ ̙̣̖̄̒ ̍˹ ̈̐˿˴̐ˢˣˤ˥̐ˢˣˤ˥̩̗̠̣̐̀̕˵̣̟̘̖̒̒̐̚˴̡̠̞̝̖̩̖̣̣̟̅̒̚˟̘̟̕ 
з̍ ˳̣̘̖̍̚̕˳ ̤̖̒̐˾̠̖̝̤̒̍̄̕ ˳̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕ 
˴̡̠̞̝̖̥̖̕ ̗̝̖̚ ̤̚ ̟̖̖̖̕̕ ̗̠̣ ̜̓̒̔ ̡̦ 
˹̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̐̚˴̡̠̞̝̖̥̖˟̘̟̕ 
˹̈̐˿˴̐ˢˣˤ˥̐ˢˣˤ˥̩̗̠̣̖̣̣̟̐̀̐̅̒̕̚˷̣̠̞˽˲̄̐˴̡̠̞̝̖̥̖˟̘̟̕ 
˹̈̐˿˴̐ˢˣˤ˥̐ˢˣˤ˥̩̗̠̣̐̀̐̕˵̣̟̘̖̒̒̚˴̡̠̞̝̖̩̖̣̣̟̅̒̐̚˴̡̠̞̝̖̥̖˟̘̟̕ 
˶̩̖̣̤̖̔̚  ˩Ь ̜̝̝̤̄̚ ̧̨̖̖̃̚ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡ˥˨̐ˡˢˣˣ̐˶̝̝̟̘̥̠̟̐̚ˤ˟̘̣̟ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡ˥˨̐ˡˢˣˣ̐˶̝̝̟̘̥̠̟̐̚˥˟̘̣̟ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡ˥˨̐ˡˢˣˣ̐˶̝̝̟̘̥̠̟̐̚˦˟̘̣̟ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡ˥˨̐ˡˢˣˣ̐˶̝̝̟̘̥̠̟̐̚˧˟̘̣̟ 
з̍ ˲̧̧̥̖̦̣̖̪̔̐̄̍̄̚ ̇̐̉̉̐ˡ˥˨̐ˡˢˣˣ̐˶̝̝̟̘̥̠̟̐̀̃̚˵̖̣̣̟̐̅̒̚˟̘̟̕ 
з̍ ̙̣̖̄̒̍˶ ̨̝̝̟̘̥̠̟̍̚ ˟̤̚̕ 
з̍ ̙̣̖̄̒̍˶ ̨̝̝̟̘̥̠̟̍̚ ˟̝̤̒ 
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˺̟̥̣̠̦̥̠̟̔̕̚ 
̙̤̅̚ ̧̠̝̦̞̖ ̨̝̝̚ ̗̠̦̤̔ ̠̟ ̥̙̖ ̤̖̓̒ ̤̖̥ ̡̦ ̗̠̣ ̥̙̖ ̧̝̔̚̚ ̡̡̝̥̠̟̤̒̔̒̚̚ ̡̖̟̠̤̀̃̒̕ ˵̖̤̘̟̖̣̚ ̟̒̕ 
̡̖̟̀˳̣̘̖̚̕ ˾̠̖̝̖̣̕˟ ˲̝̝ ̧̝̔̚̚ ̖̟̘̟̖̖̣̤̚ ̤̙̠̦̝̕ ̧̙̖̒ ̒ ̤̠̝̚̕ ̨̜̟̠̝̖̘̖̕ ̤̖̓̒ ̠̗ ˸̡̖̠̘̣̙̒̔̚ 
˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̤̄ ̟̒̕ ̦̟̖̣̤̥̟̒̕̕ ̥̙̖ ̦̤̖̤ ̠̗ ̥̒̒̕ ̢̦̤̥̠̟̒̔̚̚̚ ̗̠̣ ̖̩̤̥̟̘̚̚ ̠̟̥̠̟̤̔̕̚̚˟ ̅ ̙̖̤̖ 
̨̨̠̣̜̗̝̠̤ ̨ ̝̝̚ ̟̠̥ ̠̦̞̖̟̥̔̕ ̖̙̒̔ ̥̠̠̝ ̥̙̥̒ ̤̚ ̧̝̝̖̒̒̒̓̚ ̠̟ ̥̙̖ ̟̥̖̣̗̖̒̔̚˟ ̖̖̄ ̥̙̖ ̠̟̝̟̖̚ ̡̙̖̝ ̗̠̣ 
̠̞̞̟̤̔̒̕ ̟̠̥ ̖̥̝̖̒̕̚̕ ̟̚ ̥̙̤̚ ̠̦̞̖̟̥̔̕˟ 
 
̧̦̣̖̪̄ ̕ ̘̟ ̗̚ ̝̖̤ ̥̙̥̒ ̧̙̖̒ ̖̖̟̓ ̥̙̣̠̦̘̙ ̥̙ ̖̂ ˴ ̡̣̠̖̤̤̔ ̣̖̒ ̧̝̝̖̒̒̒̓̚ ̗ ̠̣ ̣̖̗̖̣̖̟̟̘̔̚ ̟̚ ̥̙̖ 
˲̧̧̥̖̦̣̖̪̔̐̄̚ ̗ ̠̝̖̣̕ ̟̚ ̖̙̒̔ ̡̛̣̠̖̥̔˟  ́ ̣̠̥̖̥̟̘̔̚ ̥̙̖ ̟̥̖̘̣̥̪̚̚ ̠̗ ̥̙̖ ̧̤̦̣̖̪ ̟̗̠̣̞̥̠̟̒̚̚ ̙̤̒ 
̨̝̪̤̒̒ ̖̖̟̓ ̒ ̠̟̖̣̟̔̔ ̗̠̣ ˴̅˵̀̅Я̤ ̧̦̣̖̪̄ ̡̖̣̤̠̟̟̖̝˟ ̟̖̣̆̕ ̟̠ ̣̦̞̤̥̟̖̤̔̔̒̔̚ ̤̙̝̝̒ ̖̤̘̟̕̚ 
̡̖̣̤̠̟̟̖̝ ̡̠̪̔ ̥̙̖ ̧̤̦̣̖̪ ̗̝̖̤̚ ̠̦̥ ̠̗ ̥̙̖ ˲̧̧̥̖̦̣̖̪̔̐̄̚ ̗ ̠̝̖̣̕ ̟̥̠̚ ̥̙̖̣̚ ̗̠̝̖̣̕ ̟̚ ̥̙̖ ̖̗̗̠̣̥ ̥̠ 
̖̥̕̚ ̥̙̖ ̧̤̦̣̖̪ ̥̒̒̕ ̠̟̥̟̖̔̒̚̕ ̟̚ ̥̙̖ ̧̦̣̖̪̄ ̗̖̝̚̕ ̠̠̜̓ˠ̥̖̣̣̟̒̚ ̖̤̘̟̕̚ ̗̝̖̚˙̤˚˟ The accuracy of 
the Survey information is the responsibility of the survey  offices  and therefore the o riginal 
survey information shall not be edited by design personnel.  If changes need to be made to the 
survey files, these changes shall be coordinated with the originator (Central and District 
Survey) of the survey data.  
̖̣̣̟̅̒̚ ˴ ̣̖̥̠̟̒̚ ˾̖̥̙̠̤̕  

The three methods used for creating an existing terrain in a Survey design file are as 
follows:  
¶ ˽̠̥̠̟̔̒̚ ̧̦̣̖̪̄ ̡̡̠̤̥̣˞ ̠̖̤̤̖̔  ̗̕ ̖̝̚̕ ̥̒̒̕ ̠̟̝̪̇ ̡̠̞̝̖̥̖̔̕ ̪̓ ̥̙̖ ̧̦̣̖̪̄ ̟̥̆̚˚ 
¶ ˺̟̠̤̃̒̕ ˵̅˾ ˴̧̠̟̖̣̤̠̟̚ ˙̠̟̝̪ ̡̠̞̝̖̥̖̔̕ ̪̓ ̥̙̖ ̧̦̣̖̪̄ ̟̥̆̚˚ 
¶ ˽̚˵˲̃ ˵̥̒̒ ˙̟̔̒ ̖̓ ̣̖̥̖̔̒̕ ̪̓ ̧̤̦̣̖̪ ̠̣ ̖̤̘̟̕̚˚ ˟ 

Design may use extract ed  LiDAR for use with non - contract  files. A use case  maybe  to  
determine drainage areas that expand outside  of the suppl ied  survey.  
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 ˧
 

̗̗̝̀̔̒̚̚ ̧̦̣̖̪̄ ˵̧̖̝̖̣̝̖̤̒̓̚ 

˿̨̖ ̖̣̣̟̅̒̚ ̡̣̠̖̤̤̖̔̕ ̨̥̙̚ ̀̃˵ ̗̖̝̠̠̜̓̚̕ 
When a new OpenRoads Location Survey is requested, the Survey Unit will use OpenRoads 
Designer to create a fieldbook and import field data.  Survey information processed with the 
ORD Survey tools are written directly to the DGN file.  Both the fieldbook and terrain model 
are embedded within the ORD design file.  

This survey  file is in  the CTDOT WorkSet Design folder  Active_Survey . The Survey DGN File 
will contain several different Models each  with distinct information and uses : 
2D Design Model  Annotation  Existing survey labels, Map features  
2D Design Model  Boundary  ROW, Property Info, Annotation  
3D Design Model  Bridge Deck  Existing bridge deck, Terrain  
3D Design Model  Existing Ground Survey  Existing Survey Feature, Terrain  
3D Design Model  Hydraulic Data  Hydraulic Section, FEMA floodplain data  
3D Design Model  Utilities  Borings, Test pits, Utility as - builts  

 
˷̘̦̣̖̚  s˞ ˶ ̩̤̥̟̘̚̚ ̧̦̣̖̪̄ ˵˸˿ ˾̠̖̝̤̕ 

˸̖̠˞˴ ̠̠̣̟̥̠̟̒̕̚̚ 

Having the correct  geographic setting on  your CAD file  provides capabilities such as:  
¶ Applying a background map to the view.  
¶ Referencing other geo - located designs and raster data.  
¶ Displaying geographic latitude and longitude.  
¶ Entering latitude and longitude data.  
¶ Interfacing with a Global Positioning System device to correlate your physical 

position with the design on a mobile computer.  
¶ Exporting to Google Earth.  

For more information on the National Geodetic Survey please  visit:   
http://www.ngs.noaa.gov/faq.shtml#WhatNAD  

http://www.ngs.noaa.gov/faq.shtml#WhatNAD
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Exercise 1  Ь Referencing  the Survey File  
This exercise  instructs users how to create a base model design file for a project. Base  model file s 
will reside within the project folder structure the  ...\ Discipline Folder \ Base_Models  folder.  

ˢ˟ˢ ˷̝̖̚ ˴̣̖̥̠̟̒̚ 

Before attempting to open or create DGN files users should make sure the following is in place:  

¶ ̙̅ ̖ ˴̅˵̀̅ ˴̀˿˿˶˴̅ ˵˵˶ ̤̪̟̖̔̕ ̥̙̣̠̦̘̙ ̙̣̖̠̟̄̒́̚ ̥

¶ ̙̅ ̖ ˴̀˾́˲̄̄ ˙̅ ̣̟̟̘̒̚̚˚ ̣́ ̛̠̖̥̔ ̪̟̖̄̔̕ 

¶ ˸̠ ̥̠ ̥̙̖ ̨̗̠̝̝̠̟̘̚ ̗̝̖̤̚ ̟̚ ̪̠̦̣ ̤̥̦̖̟̥̕ ̗̠̝̖̣̕ ̒ ̟̕ ̣̘̙̥̚ ̝̜̔̔̚ ̠̟ ̤̖̝̖̥̔ ˲̨̝̪̤̒ ˼̡̖̖ ̠̟ 
̥̙̤̚ ̧̖̖̔̕̚ 
̙̣̖̄̒̍̀ ̩̗̠̣̍̕˩ ˩˦˨ˣˡ̟̖̐˟̝̤̒ 
̙̣̖̄̒̍̀ ̩̗̠̣̍̕˩ ˩˦˨ˣˡ̨̟̐˟̝̤̒ 
̙̣̖̄̒̍̀ ̩̗̠̣̍̕˩ ˩˦˨ˣˡ̟̖̐˟̥̗̚ 
̙̣̖̄̒̍̀ ̩̗̠̣̍̕˩ ˩˦˨ˣˡ̟̖̐˟̤̚̕ 

̙̣̖̄̒̍˶ ̝̝̟̘̥̠̟̍̚l ˩˦˩˪ˡ̨̟̐˟̝̤̒ 
̙̣̖̄̒̍˶ ̝̝̟̘̥̠̟̍̚l ˩˦˩˪ˡ̟̖̐˟̤̚̕ 
̙̣̖̄̒̍˶ ̝̝̟̘̥̠̟̍̚l ˩˦˩˪ˡ̨̟̐˟̤̚̕ 
̙̣̖̄̒̍˶ ̝̝̟̘̥̠̟̍̚l ˩˦˩˪˦̤̖̐˟̤̚̕ 

1. Launch the Application.   On your desktop double click on the  Accounting Icon . 

 
˷̘̦̣̖̚  x˞ ˴ ̅˵̀̅ ˴˲˵ ˲̠̦̟̥̟̘̔̔̚ ˺̠̟̔  

2. On the CTDOT Accounting Menu there will be several 
applications to pick.  In the  Run Program  field select the 
needed program : 
¶ Compass OpenRoads CE  or  Compass OpenBridge 

CE 
¶ for  the  Available Account  select OVERHEAD for 

training proposes .  
¶ Click on the  Start  button to load the program.  

˷̘̦̣̖̚  ʕ˞ ˴ ̅˵̀̅ ˴˲˵ ˲̠̦̟̥̔̔ 
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 ˩
 

3. After launching the program,  a Welcome Screen for  OpenRoads Designer  will 
appe ar.  OpenRoads u sers will continue to Step 4. 

 

For OpenBridge Designer  a home dialog box for open. OpenBridge users will need 
to complete  a. and b. below before moving on to Step 3.   

a. On the OpenBridge Designer Home dialog box select  New  to create a new 
OBDX file in your C or D drive. Name the file with your initials and Training. 
(example:  ABC_ TRAINING.obdx ).  

 
˷̘̦̣̖̚  ˥˞ ̀ ̡̖̟˳̣̘̖̚̕ ˵̖̤̘̟̖̣̚ ̡̖̟̀ ̣̖̖̟̄̔ 

b. On the left side menu unsure that  Standalone  has been selected (not BIM 
Workflow). Select or create a New Group to expose the  OpenBridge 
Modeler icon . On the left menu make sure you a have 
the  Group  selected  not a DGN file . After selecting the  Group  click on 
the  OpenBridge Modeler  icon.  

 
˷̘̦̣̖̚  ˦˞ ̀ ̡̖̟˳̣̘̖̚̕ ˵̖̤̘̟̖̣̚ ̡̖̟̀ ˵˸  ˿
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 ˪
 

4. Ensure you are using the  Custom Configuration  and  CT_WorkSpace , then select the 
relevant  WorkSet  (Training WorkSet s start with 9999_000 1, select the # that you were 
assigned )  and  Role . The example below shows the options available in OpenRoads 
Designer , OpenBridge, will look similar. The WorkSets  listed correspond to project numbers 
and will be the same for all products.  

5. Select the  New File  icon.  

 
˷̘̦̣̖̚  ˧˞ ̀ ̡̖̟̠̤̃̒̕ ̥̣̥̄̒ ̣̖̖̟̄̔  

6. From the New dialog box, Save in:  browse to the proper discipline folder and enter  the File 
Name : 

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Westbrook.dgn  
or  

OBM -  з\ Bridge \ Base_Models \ SB_CB_1234_1234_Westbrook.dgn  

7. click the  Browse  button to select the proper seed file. See below for each application's seed 
file locations.  

ORD: CT_Configuration \ Organization \ Seed \ Road \ Seed2D -  CT RoadDesign.dgn  
or  
OBM: CT_Configuration \ Organization \ Seed \ Bridge \ Seed3D -  CT BridgeDesign.dgn  

8. Follow the prompts to create the file.  

 
˷̘̦̣̖̚  ˨˞ ˿ ̨̖ ˷̝̖̚ 
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ˢ˟ˣ ̖̗̖̣̖̟̖̃̔ ˲̥̥̙̞̖̟̥̤̒̔ 
References are used to display the contents of another DGN file within the current ORD and 
OBM models. The Home tab in each Workflow contains the reference tools as shown below. 
This is no different for existing data, terrains and survey topo will be referenced into design 
models.  

 
˷̘̦̣̖̚  ˩˞ ˲ ̥̥̙̒̔ ̖̗̖̣̖̟̖̃̔ 

1. In th e Upper left corner of the application s elect The CTDOT Workflow.  

 
˷̘̦̣̖̚  ˪˞ ˴ ̅˵̀̅ ̨̠̣̜̗̝̠̈ 

2. Select the Home  tab , in the Primary  section click on the Attach Tools  pull down and choose 
the Reference s tool.  

 
˷̘̦̣̖̚ ˢ l˞ ̃ ̖̗ ̖̣̖̟̖̤̔ ̠̠̝̅ 
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ˢˢ 
 

3. On the References dialog box select Tools \  Attach з 

 
˷̘̦̣̖̚ ˢ s˞ ˲ ̥̥̙̒̔ ̖̗̖̣̖̟̖̤̃̔ ̠̠̝̅ 

Browse to attach : Active_Survey \ SV_XX_0154 - 0128_Westbrook_ORD.dgn . Assure the 
Attachment  Method is set to Interact ive  and  Save Rel ative Path is on . Select Open . 

Note:  If the selected file does not belong to the active WorkSet, you will get an alert 
mentioning the same. Click OK to continue.  

 
˷̘̦̣̖̚ ˢ x˞ ˲ ̥̥̙̒̔ ̖̗̖̣̖̟̖̃̔ ˷̝̖̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˢ x
 

4. On the Reference Attachment  Properties  select  (see page 12 for OpenBridge) : 

̡̖̟̠̤̀̃̒̕ 
Model: Existing Ground Survey  
Orientation:  Coincident  World  
Detail Scale : 1в =  40Я 
Nested Attach ments:  No Nesting  
Toggle  Annotation Scale : ON 

    
˷̘̦̣̖̚ ˢ ʕ˞ ̀ ̡̖̟̠̤̃̒̕ ̃ ̖̗̖̣̖̟̖̔ ̖̥̥̟̘̤̄̚ 
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̡̖̟̀˳̣̘̖̚̕ 
Model: Existing Ground Survey  
Orientation:  Coincident World  
Detail Scale : Full Size 1 = 1 
Nested Attachments:  No Nesting  
Toggle  Annotation Scale : ON 

 
˷̘̦̣̖̚ ˢ ˥˞ ̀ ̡̖̟˳̣̘̖̚̕ ̖̗̖̣̖̟̖̃̔ ̖̥̥̟̘̤̄̚ 

˳̖̤̥ ̣̥̖́̒̔̔̚˫ ̖̗̖̣̖̟̖̃̔ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ̥̠ ̛̣̠̖̥́̔ ˷̝̖̚ 
̥̙̈̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̖̝̖̞̖̟̥̤ ̤̥̠̣̖̕ ̟̚ ˤ˵ ̖̤̘̟̕̚ ̗̝̖̤̚˝ ̥̙̖̪ ̣̖̒ ̖̤̝̪̒̚ ̤̙̣̖̒̕ ̟̒̕ ̦̤̖̕ ̪̓ ̞̟̪̒ 
̦̤̖̣̤˟ ̙̖̅ ̞̠̤̥ ̠̞̞̠̟̔ ̨̨̠̣̜̗̝̠ ̗̠̣ ̖̤̘̟̕̚ ̡̛̣̠̖̥̤̔ ̤̚ ̥̠ ̡̤̞̝̪̚ ̣̖̗̖̣̖̟̖̔ ̥̙̖ ˤ˵ ̖̤̘̟̕̚ ̗̝̖̚ 
̥̙̥̒ ̠̟̥̟̤̔̒̚ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̥̠ ̪̠̦̣ ˣ˵ ̨̠̣̜̟̘̚ ̠̣ ̡̛̣̠̖̥̔ ̗̝̖̚˟ ̀ ̟̖̔ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚  
̥̥̙̖̒̒̔̕˝ ̥̙̖ ̥̖̣̣̟̒̚ ̥̒̒̕ ̤̚ ̖̤̤̝̖̒̔̔̓̚ ̪̓ ̝̝̒ ̠̥̙̖̣ ̠̞̞̟̤̔̒̕˟ ˲ ̤ ̒ ̣̖̗̖̣̖̟̖̔ ̗̝̖̚˝ ̥̙̖ ̥̖̣̣̟̒̚ 
̞̠̖̝̕ ̟̔̒ ̖̓ ̡̤̝̪̖̒̕̚̕ ̗̗̖̣̖̟̥̝̪̕̚ ̖̙̒̔ ̥̞̖̚ ̥̤̚ ̣̖̗̖̣̖̟̖̔̕ ̨̝̝̠̟̘̒̚ ̠̟̥̠̦̣̤̔ ̥̠ ̖̓ ̧̨̖̖̚̕ ̪̓ 
̠̟̖ ̣̖̗̖̣̖̟̖̔˝ ̨ ̙̝̖̚ ̟̠̥̙̖̣̒ ̨̣̟̘̒̕̚ ̠̣ ̦̤̖̣ ̧̨̖̤̚ ̥̣̟̘̝̖̤̒̚ ̠̣ ̠̟̥̠̦̣̤̔ ̥̒ ̒ ̗̗̖̣̖̟̥̕̚ ̧̟̥̖̣̝̒̚˟ 
˳̖̦̤̖̔̒ ̧̖̖̣̪̠̟̖ ̦̤̟̘̚ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚ ̣̖̗̖̣̖̟̟̘̔̚ ̥̙̖ ̤̞̖̒ ̤̠̦̣̖̔˝ ̟̪̒ ̡̦̥̖̤̒̕ ̥̠ ̥̙̖ 
̥̖̣̣̟̒̚ ̞̠̖̝̕ ̣̖̒ ̦̥̠̞̥̝̝̪̒̒̔̒̚ ̡̡̣̠̘̥̖̒̒̕ ̥̠ ̝̝̒ ̦̤̖̣̤˟ 
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5. Repeat  Step s 3 and 4  and reference in the  
following models : 
¶ ˲̟̟̠̥̥̠̟̒̚ 
¶ ˳̣̘̖̚̕ ˵̖̜̔ 
¶ ˳̠̦̟̣̪̒̕ ˾̠̖̝̕ ̤

6. Click Fit View  in the view window.  

7. Double - check that the survey ground file came in 
at the correct location. Zoom  to a coordinate grid 
cross  and Intercept Snap  to it, the XY- axis  below 
the view  window should display the same 
numbers as the northing and easting of the 
coordinate grid cross.  

 

8. This next step is for OpenBridge only, to see the Line Styles of lines that use Annotation Scale  
as well as the Northing and Easting coordinate grid cross , open the Models  dialog box and 
in Properties set Annotation  Scale  to ˢвˮ˥ˡЯ and Line Style Scale to Annotation Scale . 

 
˷̘̦̣̖̚ ˢ ˧Ь ˲ ̟̟̠̥̥̠̟̒̚ ̝̖̄̔̒ 

 
˷̘̦̣̖̚ ˢ ˨Ь ˾ ̠̖̝̕ ˽̟̖̚ ̥̪̝̖̄ ̝̖̄̔̒ 

˷̘̦̣̖̚ ˢ ˦Ь ˴ ̙̖̜̔ ˿̠̣̥̙̟̘̚ ̟̒̕ ˶̤̥̟̘̒̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˢ ˦
 

9. Right Click Hold  in the view and select View Control / Ref Adjust Colors .  This will dither out 
the references,  so your design pops out front.  

 
˷̘̦̣̖̚ ˢ ˩˞ ˲ ̛̦̤̥̕ ̖̗̖̣̖̟̖̃̔ ˷̝̖̚ ˴̠̝̠̣ using Right Click Menu  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˢ ˧
 

10. To adjust back open the Reference s d ialog box and select all the Referenced Models . In the 
top menu select ̡̣̠̖̣̥̖̤́̚ ˯ ˲̛̦̤̥̕ ˴̠̝̠̣̤з 

 
˷̘̦̣̖̚ ˢ˪˞  ̃ ̖̗̖̣̖̟̖̔̕ ˾̠̖̝̤̕ ˲ ̛̦̤̥̕ ˴̠̝̠̣̤ 

11. Slide Value  and Saturation  to 100. 

 
˷̘̦̣̖̚ ˣ l˞ ˲ ̛̦̤̥̕ ̖̗̖̣̖̟̖̃̔ ˷̝̖̚ ˴̠̝̠̣ ̚ ̟ ̖̗̖̟̖̤̃̔ ˵̚ ̝̠̘̒ ˳̠  ̩

12. Turn off levels as needed.   Review the file and  Save Settings . 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˢ ˨
 

ˢ˟ˤ ̖̣̣̟̅̒̚ ˾̠̖̝̤̕ 

The Existing Ground Survey model is a Terrain model generated by OpenRoads Survey and is  
stored in the design file as a Terrain Model element type.  The terrain model can be accessed 
by design personnel by attaching the survey design file as a reference attachment.  This was 
done in the steps above when the Existing Ground Survey model was referenced in.  

˲ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚ ̒ ̤̖̥ ̠̗ ̥̣̟̘̝̖̤̒̚ ̞̥̙̖̞̥̝̝̪̒̒̔̒̚ ̡̠̞̦̥̖̔̕ ̗̣̠̞ ̡̠̟̥̚ ̥̒̒̕ ̠̝̝̖̥̖̔̔̕ ̗̣̠̞ 
̥̙̖ ̤̦̣̗̖̒̔ ̖̟̘̓̚ ̞̠̖̝̖̕̕˟ ̙̖̪̅ ̣̖̒ ̡̥̪̝̝̪̔̒̚ ̦̤̖̕ ̥̠ ̞̠̖̝̕ ̙̘̙̝̪̚ ̣̣̖̘̦̝̣̒̚ ̤̦̣̗̖̤̒̔˝ ̝̜̖̚ ̥̙̖ 
̤̦̣̗̖̒̔ ̠̗ ̥̙̖ ̖̣̥̙̒˟ ˲ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚ ̣̖̥̖̔̒̕ ̗̣̠̞ ˤ˵ ̗̖̥̦̣̖̤̒ ̤̦̙̔ ̤̒ ̡̠̟̥̤̚˝ ̣̖̜̝̟̖̤̓̒̚˝ ̟̒̕ 
̠̟̥̠̦̣̤̔˟ ̖̣̣̟̅̒̚ ̞̠̖̝̤̕ ̣̖̒ ̝̤̠̒ ̣̖̗̖̣̣̖̕ ̥̠ ̤̒ ̘̥̝̒̕̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̤̕ ˙˵̅˾̤˚˝ ̥̣̟̘̦̝̥̖̒̒̚̕ 
̣̣̖̘̦̝̣̒̚ ̨̟̖̥̠̣̜̤ ˙̅˺˿̤˚˝ ̠̣ ̥̣̟̘̦̝̥̖̒̒̚̕ ̤̦̣̗̖̤̒̔˟  

˲ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚ ̤̥̠̣̖̕ ̤̒ ̒ ˤ˵ ̞̖̤̙ ̖̝̖̞̖̟̥ ̟̚ ̒ ˤ˵ ̖̤̘̟̕̚ ˙˟̘̟̕˚ ̗̝̖̚˝ ̤̞̝̣̒̚̚ ̥̠ ̨̙̥̒ ̦̤̖̕ 
̥̠ ̖̓ ̤̥̠̣̖̕ ̟̚ ̟̒ ˺̟̠̤̃̒̕ ˵̅˾ ̗̝̖̚˟ ̙̖̟̈ ̪̠̦ ̤̖̝̖̥̔ ̒ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̟̚ ̥̙̖ ̖̤̘̟̕̚ ̗̝̖̚˝ ̥̙̖ 
˶̝̖̞̖̟̥ ̖̝̖̥̠̟̄̔̚ ̥̠̠̝ ̣̖̠̘̟̫̖̤̔̚ ̥̚ ̤̒ ̒ ̖̣̣̟̅̒̚ ˾̠̖̝̕˝ ̟̒̕ ̥̙̖ ̡̣̠̖̣̥̖̤́̚ ̟̒̕ ˶̡̩̝̠̣̖̣ 
̨̟̠̤̈̚̕ ̨̝̝̚ ̨̤̙̠ ̥̚ ̤̒ ̒ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˶̝̖̞̖̟̥˟ ̙̖̅ ̡̤̝̪̒̕̚ ̠̗ ̒ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̟̚ ̥̙̖ ̡̣̠̦̥̔̕ 
̤̚ ̠̟̥̣̠̝̝̖̔̕ ̪̓ ̦̤̟̘̚ ̒ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚ ̟̒̕ ˶̝̖̞̖̟̥ ̡̖̞̝̥̖̅̒˟ 

̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ̠̟̥̟̔̒̚ ̨̥̠ ̡̥̪̖̤ ̠̗ ̗̖̥̦̣̖̤̒˫ 

¶ ̠̦̣̖̄̔ ˷̖̥̦̣̖̤̒ ̣̖̒ ̣̖̥̖̔̒̕ ̗̣̠̞ ̥̙̖ ̤̠̦̣̖̔ ̥̒̒̕ ̡̞̠̣̥̖̚̕ ̥̠ ̣̖̥̖̔̒ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ 
̟̒̕ ̟̝̦̖̔̚̕ ˳̣̖̜̝̟̖̤̒̚˝ ˳̠̦̟̣̪̒̕˝ ˺̡̞̠̣̥̖̕ ˴̠̟̥̠̦̣̤˝ ˺̤̝̟̤̒̕˝ ˹̠̝̖̤˝ ̠̤̇̚̕˝ ̟̒̕ ˷̖̥̦̣̖̒ 
̡̠̥̤̄˟  

¶ ˴̝̦̝̥̖̒̔̒̕ ˷̖̥̦̣̖̤̒ ̣̖̒ ̧̖̣̖̕̚̕ ̠̣ ̝̦̝̥̖̔̒̔̒̕ ̗̣̠̞ ̥̙̖ ̤̠̦̣̖̔ ̗̖̥̦̣̖̤̒ ̟̒̕ ̟̝̦̖̔̚̕ 
˴̠̟̥̠̦̣̤˝ ̣̟̘̝̖̤̅̒̚˝ ̡̠̥̤̄˝ ˷̨̝̠ ˲̨̣̣̠̤˝ ˽̨̠ ̠̟̥̤́̚˝ ̟̒̕ ˹̘̙̚ ̠̟̥̤́̚˟ 

̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ̝̤̠̒ ̠̟̥̟̔̒̚ ̨̥̠ ̡̥̪̖̤ ̠̗ Ю̡̤̠̥Я ̡̠̟̥̤̚˝ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̟̒̕ ̡̠̥̤̄˟ 

¶ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̣̖̒ ̒ ̠̦̣̖̄̔ ˷̖̥̦̣̖̒ ̟̒̕ ̠̟̥̟̔̒̚ ̥̙̖ ̩˝̪˝̫ ̟̗̠̣̞̥̠̟̒̚̚ ̗̣̠̞ ̡̞̠̣̥̖̚̕ 
̡̠̟̥̚ ̥̒̒̕˟ 

¶ ̡̠̥̤̄ ̣̖̒ ̒ ˴̝̦̝̥̖̒̔̒̕ ˷̖̥̦̣̖̒ ̟̒̕ ̠̟̥̟̔̒̚ ̥̙̖ ̩˝̪˝̫ ̟̗̠̣̞̥̠̟̒̚̚ ̥̒ ̝̝̒ ̠̗ ̥̙̖ ̥̣̟̘̝̖̒̚ 
̧̖̣̥̖̤̔̚ ̟̚ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕˟ 

˺̟ ̟̒ ̖̩̤̥̟̘̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕˝ ̥̚ ̤̚ ̡̠̤̤̝̖̓̚ ̟̒̕ ̠̗̥̖̟ ̝̜̖̝̪̚ ̥̙̥̒ ̥̙̖ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̟̒̕ ̡̠̥̤̄ ̨̝̝̚ 
̖̓ ̥̙̖ ̤̞̖̒˟ ˺̟ ̒ ̡̠̞̝̖̩̖̔̕ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̨̙̖̣̖ ̟̒ ̖̩̤̥̟̘̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̟̒̕ ̒ ̡̡̣̠̠̤̖̕ 
̖̤̘̟̕̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̧̙̖̒ ̖̖̟̓ ̠̞̟̖̔̓̚̕˝ ̪̠̦ ̨̝̝̚ ̤̖̖ ̗̗̖̣̖̟̖̤̔̕̚ ̟̚ ̥̙̖ ̡̠̟̥̤̚˟ 
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ˢ˟ˤ˟ˢ ˵̖̗̟̟̘̚̚ ̥̙̖ ˲̧̥̖̔̚ ̖̣̣̟̅̒̚ 

After attaching the survey design file containing the terrain model element, it is normal 
̡̣̥̖̒̔̔̚ ̥̠ ̤̖̥ ̥̙̤̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̒ ̥̙̖ б˲̧̥̖̔̚ ̖̣̣̟̅̒̚в˟  The active terrain model is used to 
define the existing ground for profiles and cross sections.   
When the terrain is activated, the software will automatically create a 3D model in the 
active design file.  This 3D model is attached as a self - reference to the active file.   

1. Use the Element Selection tool to select the terrain boundary, Activate the terrain  by 
clicking on the terrain boundary, hover over the boundary and from the pop - up menu 
select/click the  Set Terrain Active  tool  (Hint for this survey  select the most western edge 
of the terrain). The command can also be selected  from the Terrain tab Active > Set 
Active .  Select the terrain model when prompted.  

 
˷̘̦̣̖̚ ˣ s˞ ̄ ̖̥ ̤̒ ˲̧̥̖̔̚ ̖̣̣̟̅̒̚ 

2. Open the Models  dialog box and notice a 3D Model Space has been created.  
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ˢ˟ˤ˟ˣ ̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ˵̡̤̝̪̒̚ ̖̥̥̟̘̤̄̚ 

The display of the terrain model is controlled by the feature definition that is assigned in the 
design file that contains the terrain element. In the example above, the terrain is displayed 
using the E_TERR_Ground feature definition.  
 
The terrain display can be defined uniquely for the active file as follows:  
The properties dialog appears as a pop - up dialog as shown below.  Since the terrain model 
is contained in a reference attachment, all the fields are ghosted and cannot be edited.  The 
user may wish to override the assigned feature definition to turn on/off contours and 
triangles or change the contour interval settings. This is accomplished by setting the 
Override Symbology option to Yes to allow editing the terrain model properties.  After setting 
the Override Symbology setting to Yes, the display of the terrain features can be toggled 
on/off using the options shown on the right for turning on/off contours, triangles, etc.  

1. Use the Element Selection tool to select th e Existing Ground Survey  terrain boundary , 
a llow the cursor to rest over the terrain element. The menu shown below appears. 
Choose Properties , and a popup will appear . This can also be seen if the Properties 
dialog  box is docked . 

2. Set the override symbology to  Yes . Then to turn off and on the Major and Minor 
contours  and  Triangles .  Watch the view display as  each property is selected.  

3. Practice with toggling On/Off other terrain features.  Leave it so the Contours  are on , but 
the Triangles  are  off . 

 
˷̘̦̣̖̚ ˣ x˞ ̀ ̧̖̣̣̖̚̕ ̪̞̠̝̠̘̪̄̓   
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˦ ˟ ˴̙̟̘̖̒ ̥̙̖ ˾̛̠̣̒ ̟̒̕ ˾̟̠̣̚ ˴̠̟̥̠̦̣ ̧̟̥̖̣̝̤̒̚˟ 

̒ ˟ ˺̟ ̥̙̖ ̡̥̠ ̠̗ ̥̙̖ ̡̣̠̖̣̥̖̤́̚ ̨̟̠̈̚̕˝ ̡̖̩̟̒̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕˫ ˶̩̤̥̟̘̖̣̣̟̐̅̒̚̚̚ ˯ 
˴̝̦̝̥̖̒̔̒̕ ˷̖̥̦̣̖̤̒ ˯ ˴̠̟̥̠̦̣̤ ˟

̓ ˟ ˺̟ ̥̙̖ ̡̥̠ ̠̗ ̥̙̖ ̡̣̠̖̣̥̖̤́̚ ̨̟̠̈̚̕ ̤̖̝̖̥̔ ˴̠̟̥̠̦̣̤ ̥ ̠ ̡̤̝̪̒̕̚ ̥̙̖ ˴̠̟̥̠̦̣̤ 
̟̗̠̣̞̥̠̟̒̚̚ ̠̩̓˟ 

̔ ˟ ˺̟ ̥̙̖ ˴̠̟̥̠̦̣̤ ̤̖̥̠̟̔̚˝ ̙̟̘̖̔̒ ̥̙̖ ˾̛̠̣̒ ˺̧̟̥̖̣̝̒ ̥ ̠ s ̒ ̟̕ ̥̙̖ ˾̟̠̣̚ ˺̧̟̥̖̣̝̒ ̥ ̠ ˟s 

̕ ˟ ˺̟ ̥̙̖ ˴̠̟̥̠̦̣̤ ̤̖̥̠̟̔̚˝ ̙̟̘̖̔̒ ̥̙̖ ̞̓ ̜̒̔ ̥̠ ˾̛̠̣̒ ˺̧̟̥̖̣̝̒ ̥ ̠ ˦ ̒ ̟̕ ̥̙̖ ˾̟̠̣̚ 
˺̧̟̥̖̣̝̒ ̥ ̠ ˟s 

˿̠̥̖ ̥̙̥̒ ̥̙̖ ̠̟̥̠̦̣̔ ̡̤̝̪̒̕̚ ̞̞̖̥̖̝̪̒̚̕̚ ̡̦̥̖̤̒̕ ̤̒ ̪̠̦ ̙̟̘̖̔̒ ̥̙̖ ̧̝̦̖̤̒˟ 

6. Review the file and  Save Settings . 

 
˷̘̦̣̖̚ ˣ  ʕ

 
˷̘̦̣̖̚ ˣ  ˥
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˿̠̥̖̤˫ 

¶ ˺̟ ̥̙̤̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕˝ ̤̒ ̟̚ ̞̟̪̒ ̥̖̣̣̟̒̚ ̞̠̖̝̤̕˝ ̪̠̦ ̨̝̝̚ ̗̟̚̕ ̥̙̥̒ ̝̝̒ ̠̗ ̥̙̖ ̗̗̖̣̖̟̥̕̚ 
̤̠̦̣̖̔ ̗̖̥̦̣̖̤̒ ̞̪̒ ̟̠̥ ̖̩̤̥̚˟ 

¶ ˺̟ ̥̙̖ ̝̠̘̒̕̚˝ ̪̠̦ ̟̔̒ ̠̦̝̖̓̕˞̔ ̝̜̔̚ ̠̟ ̒ ̗̖̥̦̣̖̒ ̟̞̖̒ ̠̣ ̥̙̖ ̟̀ˠ̗̗̀ ̟̥̠̣̔̒̚̕̚ ̥̠ 
̥̠̘̘̝̖ ̥̙̥̒ ̗̖̥̦̣̖̒ ̡̤̝̪̒̕̚ ̠̟ˠ̠̗̗˟ 

¶ ˺̗ ̪̠̦ ̥̠̘̘̝̖ ̝̝̒ ̥̙̖ ̗̖̥̦̣̖̒ ̡̤̝̪̤̒̕̚ ̠̗̗˝ ̥̙̖ ̠̦̟̣̪̓̒̕ ̗̖̥̦̣̖̒ ̨̝̝̚ ̤̥̝̝̚ ̖̓ ̡̤̝̪̖̒̕̚̕˟ 
˲̥ ̝̖̤̥̒ ̠̟̖ ̗̖̥̦̣̖̒ ̙̤̒ ̥̠ ̖̓ ̡̤̝̪̖̒̕̚̕ ̟̚ ̠̣̖̣̕ ̗̠̣ ̥̙̖ ̥̖̣̣̟̒̚ ̥̠ ̖̓ ̤̖̝̖̥̖̔̕ ̟̒̕ 
̥̙̖ ̠̦̟̣̪̓̒̕ ̤̚ ̥̙̖ ̖̗̦̝̥̒̕ ̗̖̥̦̣̖̒ ̥̙̥̒ ̨̝̝̚ ̖̓ ̡̤̝̪̖̒̕̚̕ ̗̚ ̝̝̒ ̥̙̖ ̗̖̥̦̣̖̤̒ ̣̖̒ 
̥̠̘̘̝̖̕ ̠̗̗˟ 

ˢ˟ˤ˟ˤ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˷̖̥̦̣̖̤̒ 

̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ̠̟̥̟̔̒̚ ̨̥̠ ̡̥̪̖̤ ̠̗ ̗̖̥̦̣̖̤̒˟ 

¶ ̠̦̣̖̄̔ ˷̖̥̦̣̖̤̒ ̒ ̣̖ ̣̖̥̖̔̒̕ ̗̣̠̞ ̥̙̖ ̤̠̦̣̖̔ ̥̒̒̕ ̡̞̠̣̥̖̚̕ ̥̠ ̣̖̥̖̔̒ ̥̙̖ ̥̖̣̣̟̒̚ 
̞̠̖̝̕ ̟̒̕ ̟̝̦̖̔̚̕ ˳̣̖̜̝̟̖̤̒̚˝ ˳̠̦̟̣̪̒̕˝ ˺̡̞̠̣̥̖̕ ˴̠̟̥̠̦̣̤˝ ˺̤̝̟̤̒̕˝ ˹̠̝̖̤˝ ̠̤̇̚̕˝ 
̟̒̕ ˷̖̥̦̣̖̒ ̡̠̥̤̄˟  

¶ ˴̝̦̝̥̖̒̔̒̕ ˷̖̥̦̣̖̤̒ ̒ ̣̖ ̧̖̣̖̕̚̕ ̠̣ ̝̦̝̥̖̔̒̔̒̕ ̗̣̠̞ ̥̙̖ ̤̠̦̣̖̔ ̗̖̥̦̣̖̤̒ ̟̒̕ ̟̝̦̖̔̚̕ 
˴̠̟̥̠̦̣̤˝ ̣̟̘̝̖̤̅̒̚˝ ̡̠̥̤̄˝ ˷̨̝̠ ˲̨̣̣̠̤˝ ˽̨̠ ̠̟̥̤́̚˝ ̟̒̕ ˹̘̙̚ ̠̟̥̤́̚˟ 

̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ̝̤̠̒ ̠̟̥̟̔̒̚ ̨̥̠ ̡̥̪̖̤ ̠̗ Ю̡̤̠̥Я ̡̠̟̥̤̚˝ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̟̒̕ ̡̠̥̤̄˟ 

˷̖̥̦̣̖̒ ̡̠̥̤̄ ̒ ̣̖ ̒ ̠̦̣̖̄̔ ˷̖̥̦̣̖̒ ̟̒̕ ̠̟̥̟̔̒̚ ̥̙̖ ̩˝̪˝̫ ̟̗̠̣̞̥̠̟̒̚̚ ̗̣̠̞ ̡̞̠̣̥̖̚̕ ̡̠̟̥̚ 
̥̒̒̕˟ 

̡̠̥̤̄ ̣̖̒ ̒ ˴̝̦̝̥̖̒̔̒̕ ˷̖̥̦̣̖̒ ̟̒̕ ̠̟̥̟̔̒̚ ̥̙̖ ̩˝̪˝̫ ̟̗̠̣̞̥̠̟̒̚̚ ̥̒ ̝̝̒ ̠̗ ̥̙̖ ̥̣̟̘̝̖̒̚ 
̧̖̣̥̖̤̔̚ ̟̚ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕˟ 

˺̟ ̟̒ ̖̩̤̥̟̘̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕˝ ̥̚ ̤̚ ̡̠̤̤̝̖̓̚ ̟̒̕ ̠̗̥̖̟ ̝̜̖̝̪̚ ̥̙̥̒ ̥̙̖ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̟̒̕ ̡̠̥̤̄ 
̨̝̝̚ ̖̓ ̥̙̖ ̤̞̖̒˟ ˺̟ ̒ ̡̠̞̝̖̩̖̔̕ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̨̙̖̣̖ ̟̒ ̖̩̤̥̟̘̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̟̒̕ ̒ 
̡̡̣̠̠̤̖̕ ̖̤̘̟̕̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̧̙̖̒ ̖̖̟̓ ̠̞̟̖̔̓̚̕˝ ̪̠̦ ̨̝̝̚ ̤̖̖ ̗̗̖̣̖̟̖̤̔̕̚ ̟̚ ̥̙̖ ̡̠̟̥̤̚˟ 

˺̟ ̥̙̖ ̨̗̠̝̝̠̟̘̚ ̡̥̦̣̖̤̔̚ ̗̣̠̞ ̒ ̡̠̞̝̖̩̖̔̕ ̥̖̣̣̟̒̚ ̞̠̖̝̕˝ ˷̖̥̦̣̖̒ ̡̠̥̤̄ ̣̖̒ ̡̤̝̪̖̒̕̚̕ ̠̟ 
̥̙̖ ̝̖̗̥ ̟̒̕ ̡̠̥̤̄ ̣̖̒ ̡̤̝̪̖̒̕̚̕ ̠̟ ̥̙̖ ̣̘̙̥̚˟ 
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ˢ˟ˤ˟˥ ̠̟̥́̚ ˷̖̥̦̣̖̤̒ 

When survey files are imported and processed, each field shot is stored as a Point Feature 
in a Field Book which is embedded in the design file.  ˷̠̣ ̡̖̩̞̝̖̒˝ ̥̙̖ ̗̖̝̚̕ ̠̖̔̕ б˵̅в ̤̚ 
̟̝̦̖̔̚̕̕ ̟̚ ̥̙̖ б̖̐̅̃˶˶˵˴̐̐˵̖̦̠̦̤̔̚̕ ̣̖̖̅в ̗̖̥̦̣̖̒ definition and  is used to designate a 
Deciduous Tree.  When survey data is processed, the tree symbology is generated in the 
design file view using a CTDOT standard cell element as shown:  

 
˷̘̦̣̖̚ ˣ ˦˞ ́ ̠̟̥̚ ̪̞̠̝̠̘̪̄̓ 

The information for an individual point can also be reviewed as follows:   
1. From the Home tab, choose the Element Selection  command.  

2. Float the cursor over a referenced survey point  and allow the cursor to rest over the 
element.  

3. A pop - up dialog will appear showing the survey information for the Point Feature.  

 
˷̘̦̣̖̚ ˣ  ˧˞ ́ ̠̟̥̚ ˷̖̥̦̣̖̒ ˺̟̗̠̣̞̥̠̟̒̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ʕ
 

ˢ˟ˤ˟˦ ˽̟̖̣̒̚ ˷̖̥̦̣̖̤̒ 

A series of survey points representing curvilinear features can be connected as a Linear 
Feature. With the Element Selection tool active, float the cursor over the referenced linear 
feature, and a pop - up menu will open with information about the Linear Fea ture.  

1. From the Home tab, choose the Element Selection  command.  

2. Float the cursor over a referenced survey line  and allow the cursor to rest over the 
element.  

3. A pop - up dialog will appear showing the survey information for the Point Feature.  

 
˷̘̦̣̖̚ ˣ ˨˞ ˽ ̟̖̣̒̚ ˷̖̥̦̣̖̒ ˺̟̗̠̣̞̥̠̟̒̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˥
 

ˢ˟ˤ˟˧ ̧̖̣̣̖̀̚̕ ̡̖̞̝̥̖̅̒ 

˺̟ ̥̙̖ ̡̧̣̖̠̦̤̚ ̤̖̥̠̟̤̔̚˝ ̪̠̦ ̧̙̖̒ ̙̟̘̖̔̒̕ ̥̙̖ ̥̖̣̣̟̒̚ ̡̤̝̪̒̕̚ ̪̓ ̞̟̦̝̝̪̒̒ ̥̦̣̟̟̘̚ ̠̟ ̟̒̕ 
̠̗̗ ̗̗̖̣̖̟̥̕̚ ̗̖̥̦̣̖̤̒ ̟̒̕ ̙̟̘̟̘̔̒̚ ̡̣̞̖̥̖̣̒̒ ̧̝̦̖̤̒˟ ˲̤ ̛̦̤̥ ̤̦̤̤̖̔̕̚̕ ̧̠̖̒̓˝ ̒ ̗̖̥̦̣̖̒ 
̖̗̟̥̠̟̕̚̚̚ ̖̗̟̖̤̕̚ ̨̙̥̒ ̟̒ ̥̖̞̚ ̤̚ ̟̒̕ ̡̠̟̥̤̚ ̥̠ ̨̙̠ ̥̚ ̨̝̝̚ ̖̓ ̡̤̝̪̖̒̕̚̕˟ ̤̟̘̆̚ ̒ ̗̖̥̦̣̖̒ 
̖̗̟̥̠̟̕̚̚̚ ̤̚ ̒ ̢̦̜̔̚ ̨̪̒ ̥̠ ̙̟̘̖̔̒ ̥̙̖ ̡̤̝̪̒̕̚ ̡̣̞̖̥̖̣̤̒̒ ̨̥̙̠̦̥̚ ̧̙̟̘̒̚ ̥̠ ̙̟̘̖̔̒ ̖̙̒̔ 
̧̟̦̝̒̚̕̚̚̕ ̤̖̥̥̟̘̚˟ 

ˢ˟ ̖̝̖̥̄̔ ̥̙ ̖̩˶ ̤̥̟̘̚̚ ̖̣̣̟̅̒̚ ̥ ̠ ̖̗̟̖̕̚ ̥̙̖ ̡̤̝̪̒̕̚ ̡̣̞̖̥̖̣̤̒̒˟ 

ˣ ˟ ˺̟ ̥̙̖ ̡̣̠̖̣̥̖̤́̚ ̨̟̠̈̚̕ ̤̖̝̖̥̔ ̥ ̙̖ ̖̗̖̣̖̟̖̃̔ ̤̖̥̠̟̔̚˫ ̗̠ ̣ ̧̖̣̣̖̀̚̕ ̡̖̞̝̥̖̅̒ ̤ ̖̝̖̥̔ 
̖̣̣̟̅̒̚ ˯ ˶̩̤̥̟̘̚̚ ̣̟̅̒̚ ̘̝̖̤ ˟

˿̠̥̖ ̥̙̥̒ ̥̙̖ ̥̣̟̘̝̖̤̒̚ ̣̖̒ ̨̟̠ ̡̤̝̪̖̒̕̚̕ ̟̒̕ ̥̙̖ ̠̟̥̠̦̣̤̔ ̒ ̣̖ ̠̗̗ ˟

 
˷̘̦̣̖̚ ˣ  ˩

ˤ ˟ ˴̙̟̘̖̒ ̥ ̙̖ ̧̖̣̣̖̀̚̕ ̡̖̞̝̥̖̅̒ ̥̠ ̖̣̣̟̅̒̍̚˶ ̩̤̥̟̘̚̚ ˴̠̟̥̠̦̣̤ ̟̝̪̀ ˟

ˢ˟ˤ˟˨ ˴̙̟̘̖̒ ̥̙ ̖ ̖̩̥̅ ̄̚ ̫̖ 

ˢ˟ ̖̝̖̥̄̔ ̥̙̖ ˵̨̣̟̘̒̚ ̣̠̦̥̠̟́̔̕̚ ̥̒̓ ̒ ̟̕ ̥̙̖̟ ̟̚ ̥̙̖ ˵̨̣̟̘̒̚ ̝̖̤̄̔̒ ̡̘̣̠̦˝ ̤̖̝̖̥̔ ̥̙̖ 
̡̣̠̕̕˞̨̠̟ ̞̖̟̦ ̟̒̕ ̙̟̘̖̔̒ ̥̙̖ ̨̣̟̘̒̕̚ ̤̝̖̔̒ ̥̠ ˢвˮxlЯ ˟ ˿ ̠̥̖ ̥̙̥̒ ̥̙̖ ̥̖̩̥ ̤̫̖̚ ̠̗ ̥̙̖ 
̛̞̠̣̒ ̠̟̥̠̦̣̔ ̝̖̝̤̒̓ ̖̔̕ ̣̖̤̖̤̒˟ 

ˣ ˟ ̨̥̙̄̔̚ ̥̙̖ ˵̨̣̟̘̒̚ ̝̖̄̔̒ ̜̓̒̔ ̥̠ ˢвˮ˥ˡЯ ˟

 
˷̘̦̣̖̚ ˣ  ˪

ˤ ˟ ̖̝̖̥̄̔ ̧̖̄̒ ̖̥̥̟̘̤̄̚ ̗ ̣̠̞ ̥̙̖ ̦̜̂̔̚ ˲̖̤̤̔̔ ̠̠̝̅˳̣̒˟ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˦
 

ˢ˟ˤ˟˩ ̡̖̥̦̄ ̟̒̕ ̧̨̣̖̖̚ ˣ˵ ̟̒̕ ˤ˵ ̨̖̇̚ ̟̒̕ ˾̠̖̝̤̕ 

˺̟ ̥̙̤̚ ̤̖̥̠̟̔̚˝ ̪̠̦ ̨̝̝̚ ̡̠̖̟ ̒ ̨̟̖ ̧̨̖̚ ̟̚ ̥̙̖ ̖̤̘̟̕̚ ̗̝̖̚ ̥̠ ̡̤̝̪̒̕̚ ̥̙̖ ˤ˵ ̞̠̖̝̕ ̥̙̥̒ ̨̤̒ 
̦̥̠̞̥̝̝̪̒̒̔̒̚ ̣̖̥̖̔̒̕ ̨̥̙̚ ̥̙̖ ̖̥̄ ˲̧̥̖̔̚ ̖̣̣̟̅̒̚ ̠̞̞̟̔̒̕˟ ̠̦̊ ̨̝̝̚ ̝̤̠̒ ̝̠̠̜ ̥̒ ̥̙̖ 
̞̠̖̝̤̕ ̟̚ ̥̙̖ ̖̤̘̟̕̚ ̗̝̖̚ ̟̒̕ ̥̙̖̣̚ ̤̤̠̥̠̟̒̔̒̚̚ ̥̠ ̥̙̖ ̡̤̝̪̖̒̕̚̕ ̧̨̖̤̚˟ 

ˢ˟ ̘̙̥̃̚˞̔ ̝̜̔̚ ̟̚ ̨̖̇̚ ˢ ̒ ̟̕ ̙̠̝̕ ̨̠̟̕ ̥̙̖ ̣̘̙̥̚ ̞̠̦̤̖ ̦̥̥̠̟̓ ̥̠ ̖̤̤̒̔̔ ̡̤̖̝̔̒̚ ̧̨̖̚ 
̠̟̥̣̠̝̔ ̥̠̠̝̤˟  

ˣ ˟ ̖̝̖̥̄̔ ̨̖̇̚ ˴̠̟̥̣̠̝ ˯ ˣ ̨̖̤̇̚ ̝̟́̒ˠˤ˵ ˟

˿̠̥̖̔̚ ̥̙̖ ̧̨̖̤̚ ̙̟̘̖̔̒˝ ̪̠̦ ̨̟̠ ̧̙̖̒ ˣ ̧̨̖̚ ̨̨̟̠̤̚̕ ̡̠̖̟˟  

̨̖̇̚ ˢ ̠̟ ̥̙̖ ̝̖̗̥ ̤̚ ̥̙̖ ˣ˵ ̞̠̖̝̕ ̧̨̖̚ ̥̙̥̒ ̪̠̦ ̤̥̣̥̖̒̕ ̨̥̙̚˝ ̟̒̕ ̨̖̇̚ ˣ ̠̟ ̥̙̖ ̣̘̙̥̚ ̤̚ ̥̙̖ 
ˤ˵ ̞̠̖̝̕ ̧̨̖̚ ̥̙̥̒ ̨̤̒ ̦̥̠̞̥̝̝̪̒̒̔̒̚ ̣̖̥̖̔̒̕ ̨̙̖̟ ̪̠̦ ̤̖̥ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̧̥̖̒̔̚˟ 

˲̝̤̠˝ ̧̠̤̖̣̖̓ ̥̙̖ ̖̩̤̥̟̘̚̚ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̠̦̟̣̪̓̒̕ ̤̚ ̡̤̝̪̖̒̕̚̕ ̟̚ ˣ˵ ̟̒̕ ˤ˵˟ ̙̖̅ ̥̖̣̣̟̒̚ 
̞̠̖̝̕ ̥̣̟̘̝̖̤̒̚ ̣̖̒ ̟̠̥ ̡̤̝̪̖̒̕̚̕ ̥̒ ̥̙̤̚ ̥̞̖̚˟ ̣̟̘̝̖̤̅̒̚˝ ̣̖̜̝̟̖̤̓̒̚˝ ̗̖̥̦̣̖̒ ̡̤̠̥̤ ̟̒̕ 
̠̟̥̠̦̣̤̔ ̟̔̒ ̖̓ ̡̤̝̪̖̒̕̚̕ ̧̒̚ ̥̙̖ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̡̡̣̠̖̣̥̖̤̚ ̤̒ ̟̖̖̖̕̕˟˿̠̥̖˫ ̣̖̤̤̟̘́̚ ̥̙̖ 
˷˪ ̜̖̪ ̠̟ ̪̠̦̣ ̜̖̪̠̣̓̒̕ ̦̥̠̞̥̝̝̪̒̒̔̒̚ ̠̟̗̘̦̣̖̤̔̚ ̥̙̖ ˣ ̨̖̤̇̚ ̝̟́̒ˠˤ˵ ̧̨̖̚ ̡̤̖̥̦ ̗̠̣ 
̪̠̦˝ ˣ˵ ̠̟ ̥̙̖ ̝̖̗̥ ̟̒̕ ˤ˵ ̠̟ ̥̙̖ ̣̘̙̥̚˟ ̙̤̅̚ ̨̝̝̚ ̠̞̖̔ ̟̚ ̙̟̪̒̕ ̤̒ ̪̠̦ ̧̞̠̖ ̥̙̣̠̦̘̙ ̥̙̖ 
̖̤̘̟̕̚ ̡̣̠̖̤̤̔˟ 

 
˷̘̦̣̖̚ ˤ  l

ˤ ˟ ˷̣̠̞ ̥̙̖ ̣̠̟̓̓̚ ̞̖̟̦ ̤̖̝̖̥̔ ˹̠̞̖ ˯ ̣̞̣̪́̒̚ ˯ ˾̠̖̝̤̕ ˟

̧̨̖̖̃̚ ̥̙̖ ˾̠̖̝̤̕ ̝̠̘̒̕̚˝ ̟̠̥̖̔̚ ̥̙̖̣̖ ̣̖̒ ˣ ̞̠̖̝̤̕ ̧̝̝̖̒̒̒̓̚˝ ˵̖̗̦̝̥̒ ̟̒̕ ˵̖̗̦̝̥̒ ˤ˵˟ 
˾̠̖̝̤̕ ̟̔̒ ̖̓ ˣ˵ ̠̣ ˤ˵˟ ˺̥Я̤ ̧̖̣̪ ̡̞̠̣̥̟̥̒̚ ̥̠ ̣̖̝̫̖̒̚ ̥̙̥̒ ̧̖̖̟ ̥̙̠̦̘̙ ̪̠̦ ̤̥̣̥̖̒̕ ̨̥̙̚ ̒ 
ˣ˵ ̖̤̘̟̕̚ ̗̝̖̚ ̥̚ ̤̚ ̡̠̤̤̝̖̓̚ ̥̠ ̧̙̖̒ ̒ ˤ˵ ̞̠̖̝̕ ̝̤̠̒ ̧̝̝̖̒̒̒̓̚ ̟̚ ̥̙̖ ̤̞̖̒ ̖̤̘̟̕̚ ̗̝̖̚˟ 
̖̝̝̃̔̒ ̥̙̥̒ ̤̖̥̥̟̘̚ ̒ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̧̥̖̒̔̚ ̦̥̠̞̥̝̝̪̒̒̔̒̚ ̣̖̥̖̤̔̒ ̒ ˤ˵ ̞̠̖̝̕ ̗̠̣ ̪̠̦˟ ̙̖̅ 
ˤ˵ ̞̠̖̝̕ ̞̦̤̥ ̖̓ ̣̖̥̖̔̒̕ ̪̓ ̥̙̖ ̨̤̠̗̥̣̖̒˟ ˵̠ ̟̠̥ ̣̖̥̖̔̒ ̪̠̦̣ ̨̠̟ ̞̠̖̝̕ ̟̞̖̒̕ 
˵̖̗̦̝̥̒ ˤ˵˝ ̥̚ ̨̝̝̚ ̟̠̥ ̨̠̣̜ ̡̡̣̠̖̣̝̪˟ 

˲̝̤̠˝ ̥̙̖ ˣ˵ ̟̒̕ ˤ˵ ̞̠̖̝̤̕ ̣̖̒ ̣̖̥̝̪̔̕̚ ̣̖̝̥̖̒̕ ̥̠ ̥̙̖ ̞̠̖̝̕ ̧̨̖̤̚˝ ̣̖̝̝̔̒ ̨̖̇̚ ˢ ̤̚ 
̟̞̖̒̕ ˵̖̗̦̝̥̒ ̟̒̕ ̨̖̇̚ ˣ ̤̚ ̟̞̖̒̕ ˵̖̗̦̝̥̒ ˤ˵˟ 

 
˷̘̦̣̖̚ ˤ s

˥ ˟ ˴̝̠̤̖ ̥ ̙̖ ˾̠̖̝̤̕ ̝̠̘̒̕̚˟ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˧
 

ˢ˟ˤ˟˪ ˶̩̤̥̟̘̚̚ ̧̦̣̖̪̄ ˽̧̖̖̝̤ 

The CTDOT CADD Standards include MicroStation levels that are specific to survey 
̟̗̠̣̞̥̠̟̒̚̚˟ ̙̖̤̖̅ ̧̝̖̖̝̤ ̣̖̒ ̡̘̣̠̦̖̕ ̟̚ ̥̙̖ ̧̝̖̖̝ ̝̣̣̪̓̒̚ ̦̤̟̘̚ ̥̙̖ ̡̣̖̗̩̚ б˶̐в˟ There are 
survey levels for features as well as annotation:  

1. Make View 1  active. Open Level  Display  and click on the Existing Ground Reference 
Model  

2. Sort By Used , explore and become familiar with the grouping s.  

 
˷̘̦̣̖̚ ˤ x˞ ̄ ̧̦̣̖̪ ˷̖̥̦̣̖̒ ˽̧̖̖̝̤ 

3. Click on the Annotation  Model  and notice the E_Annot  grouping . 

 
˷̘̦̣̖̚ ˤ ʕ˞ ̄ ̧̦̣̖̪ ˲̟̟̠̥̥̠̟̒̚ ˽̧̖̖̝̤ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˨
 

 
˽̧̖̖̝ ̡̤̝̪̒̕̚ ̤̖̥̥̟̘̚ ˙̡̠̥̠̟̚ ̞̖̟̦˚ ˞ ̄ ̖̥̤ ̥̙̖ ̧̝̖̖̝ ̡̤̝̪̒̕̚ ̗̠̣ ̥̙̤̚ ̝̠̘̒̕̚˟ 
¶ ̨̖̇̚ ˵̡̤̝̪̒̚ Э ˴ ̙̟̘̖̤̒ ̟̚ ̥̙̖ ̧̝̖̖̝ ̡̤̝̪̒̕̚ ̗̗̖̥̒̔ ̥̙̖ ̙̠̤̖̟̔ ̧̨̖̚ ̟̚ ̥̙̖ ̧̥̖̒̔̚ 
̞̠̖̝̕˟ 

¶ ˸̝̠̝̓̒ ˵̡̤̝̪̒̚ Э ˴ ̙̟̘̖̤̒ ̟̚ ̥̙̖ ̧̝̖̖̝ ̡̤̝̪̒̕̚ ̗̗̖̥̒̔ ̝̝̒ ̧̨̖̤̚ ̟̚ ̝̝̒ ̞̠̖̝̤̕ ̟̚ ̥̙̖ 
̡̠̖̟ ̗̝̖̚˟ 

¶ ˸̝̠̝̓̒ ˷̣̖̖̫̖ Э˺̟̥̖̤̔̒̕̚ ̨̙̖̥̙̖̣ ̥̙̖ ̧̝̖̖̝ ̤̚ ̗̣̠̫̖̟˟ ˺̗ ̗̣̠̫̖̟˝ ̖̝̖̞̖̟̥̤ ̠̟ ̥̙̖ ̧̝̖̖̝ 
̣̖̒ ̟̠̥ ̡̤̝̪̖̒̕̚̕ ̟̒̕ ̟̟̠̥̔̒ ̖̓ ̡̣̟̥̖̚̕˟ ˺̗ ̨̖̇̚ ˵̡̤̝̪̒̚ ̠̣ ˸̝̠̝̓̒ ˵̡̤̝̪̒̚ ̤̚ ̠̗̗˝ ̠̣ ̗̚ 
˸̝̠̝̓̒ ˷̣̖̖̫̖ ̤̚ ̠̟ ̗̠̣ ̥̙̖ ̧̝̖̖̝ ̠̟ ̨̙̙̔̚ ̥̙̖ ̣̖̗̖̣̖̟̖̔ ̤̚ ̡̝̖̒̔̕˝ ̖̝̖̞̖̟̥̤ ̟̚ ̥̙̖ 
̣̖̗̖̣̖̟̖̔ ̣̖̒ ̟̠̥ ̡̤̝̪̖̒̕̚̕˟ 

 

 
˷̘̦̣̖̚ ˤ ˥Ь ˽ ̧̖̖̝ ˵̡̤̝̪̒̚ ̡̥̠̟̤̀̚ 

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˩
 

Exercise 2  Ь Referencing Old V8i  Files  
̙̖̅ ̠̣̜̟̘̈̚ ̟̆ ̥̤̚ ̠ ̗ ˵˸˿ ̗̚ ̝̖̤ ̙̟̘̖̔̒̕ ̨̥̙̚ ˴̀˿˿˶˴̅ ˶̥̠̟̕̚̚˟  ̙̖̣̖̅ ̨̝̝̚ ̖̓ ̥̞̖̤̚ ̠̝̕ ̗̝̖̚ ̤̔ ̣̖̥̖̒̕ 
̟̚ ̇˩̚ ̨̝̝̚ ̟̖̖̕ ̥ ̠ ̖̓ ̣̖̗̖̣̖̟̖̔˟  ̙̤̅̚ ˶̩̖̣̤̖̔̚ ̨̝̝̚ ̖̥̝̒̕̚ ̥̙̖ ̡̣̠̖̦̣̖̔̕ ̥ ̠ ̘̖̥ ̥̙̖ ̗̝̖̤̚ ̥̠ ̝̟̖̚ ̡̦ 
̡̘̖̠̤̥̝̝̪̒̒̚˟ 

ˣ˟ˢ ˷̝̖̚ ˴̣̖̥̠̟̒̚ 

1. Select New  File  to create a new file.  From the New dialog box, browse to the proper 
discipline  folder and enter  File Name :. 

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Branford.dgn   
or   

OBM -  з\ Bridge \ Base_Models \  SB_CB_1234_1234_Branford.dgn  
 

2. On the New dialog box click the  Browse  button to select the proper seed file. See below for 
each application's seed file locations.  

ORD: CT_Configuration \ Organization \ Seed \ Road \ Seed2D -  CT RoadDesign.dgn  
or  
OBM: CT_Configuration \ Organization \ Seed \ Bridge \ Seed3D -  CT BridgeDesign.dgn  

3. Follow the prompts to create the file.  

 
˷̘̦̣̖̚ ˤ˦˞ ˿ ̨̖ ˷̝̖̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˣ  ˪
 

ˣ˟ˣ ̖̗̖̣̖̟̖̃̔ ˲̥̥̙̞̖̟̥̤̒̔ 

In this portion of the exercise,  you will be referencing  two files.  

¶ The Ground  Topo design file previously created using V8i.  Sometimes  you will have 
several ground files and on very old files the extensions maybe .grn . 

¶ The ORD Terrain  survey  file, this file was created by importing a n old V8i InRoads DTM  

1. Select the Reference tool.  

Browse to attach : Active_Survey \ SV_XX_0098_0103_Branford_GRN.dgn  

Attachment Method is set to Interactive  and  Save Relative Path is on . Select Open . 

On the Reference Attachment Properties select : 
Model: 3D Design  
Orientation:  Coincident World  
Open Roads - Detail Scale : s вˮ˥ˡЯ    Open Bridge - Detail Scale : Full Size  1 = 1 
Nested Attachments:  No Nesting  
Toggle  Annotation Scale : ON 

       
˷̘̦̣̖̚ ˤ  ˧˞ ̀ ̃˵ ˙̝̖̗̥˚ ̟̒̕ ̀˳˾ ˙̘̙̥̃̚˚ ̖̗̖̣̖̟̖̃̔ ̖̥̥̟̘̤̄̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  l
 

2. Click Fit View  in the view window. Double - check that the survey ground file came in at the 
correct location. Zoom  to a coordinate grid cross  and snap  to it, the XY- axis ,  

3. Notice the coordinates  do no match up.  

 
˷̘̦̣̖̚ ˤ ˨Ь ˴ ̠̠̣̟̥̖̤̒̕̚ ̠̕ ̟̠̥ ̞̥̙̒̔ 

4. In the References dialog box change  True Scale to off  and the scale to  1 to 1. 

5. Fit  the view and re - check the coordinates, they should now line up.  

 
˷̘̦̣̖̚ ˤ  ˩˞ ̃ ̖̗̖̣̖̟̖̔ ̗ ̝̖̚ ̖̥̥̟̘̤̄̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ s
 

6. Select the Reference tool.  Browse to attach : 
Active_Survey \ SV_XX_0098_0103_Branford_ORD_Terrain.dgn  

Attachment Method is set to Interactive  and  Save Relative Path is on . Select Open . 

On the Reference Attachment Properties select : 
Model: Default  
Orientation:  Coincident  World  
Open Roads - Detail Scale : s вˮ˥ˡЯ    OpenBridge - Detail Scale: Full Size 1 = 1 
Nested Attachments:  No Nesting  
Toggle  Annotation Scale : ON 

     
˷̘̦̣̖̚ ˤ  ˪˞ ̀ ̃˵ ˙̝̖̗̥˚ ̟̒̕ ̀˳˾ ˙̘̙̥̃̚˚ ̖̗̖̣̖̟̖̃̔ ̖̥̥̟̘̤̄̚ 

7. Click Fit View  in the view window.  Double - check that the survey ground file came in at the 
correct location. Zoom  to a coordinate grid cross  and snap  to it, the XY- axis , the 
MicroStation command window should display the same numbers as the northing and 
easting of the coordinate grid cross.  

8. Review the file and  Save Settings  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  x
 

ˣ˟ˤ ˽̟̖̚ ̥̪̝̖̄ ̝̖̄̔̒ 

̥̈̚ ̙̤ ̠̞̖ ̠̝̕ ̗̝̖̤̚ ̥̙̖ ˽̟̖̚ ̥̪̝̖̄ ̄ ̝̖̔̒ ̞ ̪̒ ̟̠̥ ̠̞̖̔ ̥̙̣̠̦̘̙ ̥ ̙̖ ̠̣̣̖̥̔̔ ̤̫̖̚ ̨ ̙̖̟ 
̣̖̗̖̣̖̟̟̘̔̚˟  ̙̖̅ ˽̟̖̚ ̥̪̝̖̄ ̞̪̒ ̠̞̖̔ ̥̙̣̠̦̘̙ ̤̠ ̤̞̝̝̒ ̥̙̖̪ ̧̨̖̚ ̤̒ ̒ ̤̠̝̚̕ ̝̟̖̚˟ ̅ ̙̤̚ ̔̒ ̟̓ ̖ 
̛̦̤̥̖̒̕̕ ̟̚ ̥̙̖ ˾̠̖̝̕ ̡̣̠̖̣̥̖̤́̚ ̟̒̕ˠ̠̣ ˲̥̥̙̞̖̟̥̒̔ ̡̣̠̖̣̥̖̤́̚ ˟ ̈̚ ̥̙ ̠̝̕ ̗̝̖̤̚ ̥̤̚ ̣̖̝̝̪̒ ̛̦̤̥ ̥̣̝̒̚ 
̟̒̕ ̖̣̣̠̣ ̨̥̙̚ ̥̙̖ ̤̖̥̥̟̘̤̚ ̤̒ ̥̤̚ ̙̣̒̕ ̥̠ ̜̟ ̨̠ ̨̙̥̒ ̨̤̒ ̠̟̖̕ ̟̚ ̥̙̖ ̣̖̗̖̣̖̟̖̔ ̗̝̖̚ ̨̙̖̟ ̥̚ ̨̤̒ 
̣̖̥̖̔̒̕ ̪̖̣̤̒ ̜̓̒̔˟ 

 
˷̘̦̣̖̚ ˥  l˞ ̈ ̣̠̟̘ ˽̟̖̚ ̥̪̝̖̄ ̝̖̄̔̒ 

̡̖̟̀ ̥̙̖ ˾̠̖̝̤̕ ̝̠̘̒̕̚ ̠̩̓ ̒ ̟̕ ̟̚ ̡̣̠̖̣̥̖̤́̚ ̤̖̥ ˲̟ ̟̠̥̥̠̟̒̚ ̝̖̄̔̒ ̥̠ sвˮ˥ˡЯ ̒ ̟̕ ˽̟̖̚ ̥̪̝̖̄ 
̝̖̄̔̒ ̥̠ ˲̟̟̠̥̥̠̟̒̚ ̝̖̄̔̒ ˟

 
˷̘̦̣̖̚ ˥ sЬ ˾ ̠̖̝̕ ˽ ̟̖̚ ̥̪̝̖̄ ̝̖̄̔̒ 

˺̟ ̥̙̖ ̖̗̖̣̖̟̖̤̃̔ ̝̠̘̒̕̚ ̠̩̓ ̠̦̝̖̓̕ ̝̜̔̔̚ ̠̟ ̥̙̖ ̖̗̖̣̖̟̖̃̔ ˷̝̖̚ ̨̥̙̚ ̠̕̕ ̝̠̠̜̟̘̚ ˽̟̖̚ ̥̪̝̖̄ ̟̒ ̕
̖̄ ̥˫ 
˸̝̠̝̓̒ ˽̟̖̥̪̝̖̄̚ ̝̖̄̔̒˫ ̖̗̖̣̖̟̖̃̔ 
˴̝̜̔̚ ̀  ˼



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ʕ
 

 
˷̘̦̣̖̚ ˥ x˞ ̄ ̖̥ ˸̝̠̝̓̒ ˽̟̖̥̪̝̖̄̚ ̝̖̄̔̒ 

˺̟ ̥̙̖ ̨̖̇̚ ̨̟̠̈̚̕ ̫̠̠ ̞ ̟̚ ̟̒̕ ̠̦̥˝ ̗̚ ̥̙̖ ˽̟̖̚  ̥̪̖̄ ̤̥̝̝̚ ̠̖̤̕ ̟̠̥ ̝̠̠̜ ̠̣̣̖̥̔̔ ̥ ̙̖ ˲̟̟̠̥̥̠̟̒̚ 
̝̖̄̔̒ ̞ ̪̒ ̟̖̖̕ ̥̠ ̖̓ ̠  ̟̠ ̣ ̠̗ ̗̕ ̡̖̖̟̟̘̕̚ ̠̟ ̥̙̖ ̣̖̗̖̣̖̟̖̔ ̗̝̖̚˟  ̙̤̅̚ ̟̔̒ ̖̓ ̛̦̤̥̖̒̕̕ ̗̥̖̣̒ 
̥̙̖ ̟̥̝̒̚̚̚ ̣̖̗̖̣̖̟̖̔ ̤̚ ̣̠̦̘̙̥̓ ̟̚˟ ˲ ̗̥̖̣ ̨̤̥̙̔̚ ̨̖̥̖̖̟̓ ̥ ̙ ̖˲ ̟̟̠̥̥̠̟̒̚ ̝̖̄̔̒ ̤̖̥̥̟̘̤̚ ̫̠̠̞ ̟̚ 
̟̒̕ ̠̦̥ ̘̟̒̒̚ ̥̠ ̤̖̖ ̥̙̖ ̣̖̤̦̝̥̤ ˟

 
˷̘̦̣̖̚ ˥ ʕЬ ˲ ̟̟̠̥̥̠̟̒̚ ̄ ̝̖̔̒ ̖̥̥̟̘̄̚ ̠ ̟ ˠ ̠̗̗  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˥
 

Exercise 3  Ь Working with Datums  

ˤ˟ˢ ˷̝̖̚ ˴̣̖̥̠̟̒̚ 
CONNECT Edition design files contain Geo - Coordination features which allow users to specify 
the position of the design contents on the Earth's surface. Once that position is established, the 
design can be easily coordinated with other data for which the ge ographic location is 
known.  The seed files in the Discipline folders have been assigned a default Geographic 
Coordinate System (GCS) of NAD 1983 State Plane Connecticut with a North American Vertical 
Datum of 1988 to allow interaction with geospatial applications. This GCS has also be en 
applied to each view as an Auxiliary Coordinate System (ACS).  Seed files of different Datums 
are available in the GCS folder for use with odd cases.  ˵̖̤̘̟̖̣̤̚ ̤̙̠̦̝̕ ̗̣̤̥̚ ̠̟̤̦̝̥̔ ̨̥̙̚ ̥̙̖ 
̧̦̣̖̪̄ ̟̥̆̚ ̥̠ ̠̥̟̓̒̚ ̥̙̖ ̠̣̣̖̥̔̔ ̥̦̞̤̒̕ ˙˿˲˵ ̟̒̕ ˿˲̇˵˚˟ ̙̤̅̚ ̠̠̣̟̥̖̔̒̕̚ ̟̗̠̣̞̥̠̟̒̚̚ ̟̔̒ 
̝̤̠̒ ̖̓ ̗̠̦̟̕ ̟̚ ̥̙̖ ̧̦̣̖̪̄ ̘̟̕ ̥̥̝̖̚ ̝̠̜̓̔ ̟̠̥̖̤˝ ̦̤̖̣̤ ̟̔̒ ̡̠̖̟ ̥̙̖ ̧̤̦̣̖̪ ̗̝̖̤̚ ̣̖̒̕ ̠̟̝̪ ̥̠ 
̧̨̖̚ ̥̙̤̚ ̟̗̠̣̞̥̠̟̒̚̚ ˟

1. Select  New File to create a new file.  From the New dialog box, browse to the proper 
discipline  folder and enter  the proper File Name : 

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Oxford.dgn  
or   

OBM -  з\ Bridge \ Base_Models \  SB_CB_1234_1234_Oxford.dgn  
 

2. On the New dialog box click the  Browse  button  and  select the following Seed File:  
ORD: CT_Configuration \ Organization \ Seed \ GCS\ 2D_ NAD83FT_NAVD88 .dgn  
or  
OBM: CT_Configuration \ Organization \ Seed \ GCS\ 3D_ NAD83FT_NAVD88 .dgn  

3. Follow the prompts to create the file.  

 
˷̘̦̣̖̚ ˥  ˥Ь ˿ ̨̖ ˷̝̖̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˦
 

ˤ˟ˣ ̖̗̖̣̖̟̖̃̔ ˲̥̥̙̞̖̟̥̤̒̔ 

In this portion of the exercise, you will be referencing two files : 

¶ The Ground  Topo design file previously created using V8i.  Sometimes you will have 
several ground files and on very old files the extensions maybe .grn . 

¶ The ORD Terrain  survey file, this file was created by importing an old V8i InRoads DTM  

1. Select the Reference tool.  

Browse to attach : Active_Survey \ SV_XX_0107_0108_Oxford_GRN.dgn  

Attachment Method is set to Interactive  and  Save Relative Path is on . Select Open . 

On the Reference Attachment Properties select : 
Model: 3D Design  
Orientation:  Coincident  World  
Open Roads - Detail Scale:  s вˮ˥ˡЯ    OpenBridge - Detail Scale: Full Size 1 = 1 
Nested Attachments: No Nesting  

2. Click Fit View  in the view window. Double - check that the survey ground file came in at the 
correct location. Zoom  to a coordinate grid cross  and snap  to it, the XY- axis ,  

3. Notice the coordinates do no match up.  

4. In the References dialog box change  True Scale to off  and the scale to  1 to 1. 

5. Fit  the view and re - check the coordinates, they should now line up.  

 
˷̘̦̣̖̚ ˥  ˦˞ ̃ ̖̗̖̣̖̟̖̔ ̗̝̖̚ ̖̥̥̟̘̤̄̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˧
 

6. Select the Reference tool.  
Browse to attach : Active_Survey \  SV_XX_0107_0108_Oxford_ORD_Terrain.dgn  

 Attachment Method is set to Interactive  and  Save Relative Path is on . Select Open . 

On the Reference Attachment Properties select : 
Model: Default  
Orientation:  Coincident World  
Open Roads - Detail Scale:  s вˮ˥ˡЯ    OpenBridge - Detail Scale: Full Size 1 = 1 
Nested Attachments: No Nesting  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˨
 

ˤ˟ˤ ˸̡̖̠̘̣̙̒̔̚ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̤̄ 
˽̖̥Я̤ explo re the Geo graphic tools  available  with the OpenX  applications  

1. Use the Intersect Snap , Place Line  command and place a line from one Northing and 
Easting Tick Mark to another.  

 
˷̘̦̣̖̚ ˥  ˧˞ ́ ̝̖̒̔ ˽̟̖̚ ̗̣̠̞ ̅̔̚ ˾̣̜̤̒ 

2. Change the Workflow to Drawing , on the  Utilities  tab in in the Geographic  section select 
Coordinate System . 

 
˷̘̦̣̖̚ ˥ ˨˞ ˴ ̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ̅ ̠̠̝̤ 

3. Notice the Geographic Coordinate  System dialog box information, this file uses NAD 83 and 
NGVD88 . 

 
˷̘̦̣̖̚ ˥  ˩˞ ˴ ̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ̄ ̖̥̥̟̘̤̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˩
 

4. In the View  window , zoom into the Survey Title Block and look for the Datum Information to 
check it against the dialog box.  Notice they do not match. There are two tools  that can be 
used to rectify this situation . Users can get the correct Coordinate System by using the 
From Library  or From File  tools . 

 
˷̘̦̣̖̚ ˥  ˪˞ ̄ ̧̦̣̖̪ ˿˟˲˟˵˟ ̟̒̕ ˿˸̇˵ ˿̠̥̖̤ 

a. A library of predefined Geographic Coordinate Systems (GCS) is available in CONNECT . 
Select the From Library  icon  to  see the list of available Datums . Browse to 
Library/Projected ( north ing ˝ ̖̤̥̟̘̒̚˝ з˚ˠNorth America/United States of 
America/ Connecticut , notice the  available datums.   This method can be confusing  as 
there are a lot of  options.  Click Cancel . 

 
˷̘̦̣̖̚ ˦  lЬ ̄ ̖̝̖̥̔ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ˷ ̣̠̞ ˽̣̣̪̓̒̚ ˺̠̟̔ 

 
˷̘̦̣̖̚ ˦ sЬ ̄ ̖̝̖̥̔ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ˷̣̠̞ ˽̣̣̪̓̒̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

ˤ  ˪
 

b. Rather than selecting a GCS from th is overwhelming library list, AEC provides seed files 
in the delivered CONNECT Workspace that can be used as a Geographic Coordinate 
System Source.  These files can be accessed by selecting the  From File  tool on the 
Geographic Coordinate System Toolbox.   The tool will apply the GCS from the selected 
source to the active design file.    

 
˷̘̦̣̖̚ ˦ xЬ ̄ ̖̝̖̥̔ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ˷ ̣̠̞ ˷̚ ̝̖ ̠̟̔̚ 

Select From File , browse  to and select  Open : 
CT_Configuration \ Organization \ Seed \ GCS\ 3D_NAD27FT_N GVD29.dgn  

13. The Geographic Coordinate System Changed dialog box will appear.  There are two 
options.  

 
˷̘̦̣̖̚ ˦  ʕ˞ Geographic Coordinate System Changed Dialog  Box 

a. First, we will see what Reproject the Data to the Geographic Coordinate System  does 
to the line place d in step one.  ̄ ̖̝̖̥̔ ˷̥̚ ̨̖̇̚˝ ̥his is not  the desired option  as it no 
longer lines up with the Survey .  Select undo to reverse this setting  and re - select Fit 
View . 

 
˷̘̦̣̖̚ ˦  ˥˞ ̃ ̡̛̖̣̠̖̥̔ ̥̙̖ ˵̥̒̒ ̥̠ ̥̙̖ ˸̡̖̠̘̣̙̒̔̚ ˴̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  l
 

b. Select  the From File  tool  again but this time select Correcting the Geographic 
Coordinate System Ь do not reproject the data .  

Notes:  
¶ Notice the line does not move and the Coordinates still match.  Zoom to one of the 

lines that was placed on the coordinate grid cross and snap to it, compare the 
graphical text with the XY - axis output . The same northing and easting number s 
appear.  

¶ If you have other Models in the file, for example a 3D Model that was created during 
the Corridor Modeling procedure you will need to repeat step 5b. 

 
˷̘̦̣̖̚ ˦  ˦˞ Coordinates  ̅ ̔̚ ˾̣̜̤̒ ˾̥̙̒̔ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥ s
 

14. Notice the Survey Notes Block and the Datum now match.   

 
˷̘̦̣̖̚ ˦  ˧˞ ˴ ̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ˴̙̖̜̔ 

7. Select Save Settings  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  x
 

Exercise 4  Ь Attaching Imagery  
There are  two ways to view areal imagery in a DGN file.  
1. Through the View as a background m ap  
2. Attaching a raster image  

˥˟ˢ ̖̝̖̥̄̔ ̨̖̇̚ ˳̜̘̣̠̦̟̒̔̕ ˾̡̒ 
1. Open the file from Exercise 3 .  

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Oxford.dgn  
or   

OBM -  з\ Bridge \ Base_Models \  SB_CB_1234_1234_Oxford.dgn  

2. Open the file for exercise 3, On the View window  icon click on  Select Back ground Map . 

 
˷̘̦̣̖̚ ˦ ˨˞ ̇ ̨̖̚ ˳̜̘̣̠̦̟̒̔̕ ̠̟̔̚ 

3. In the  Map  Type pull down  select  Background Map Type . Select Road , Aerial , or  Hybrid . 
 

 
˷̘̦̣̖̚ ˦  ˩˞ ˳ ̜̘̣̠̦̟̒̔̕ ˾̡̒ ̡̪̖̅ ̜́̔̚ ˽̤̥̚ 

       
˷̘̦̣̖̚ ˦  ˪˞ ˳ ̜̘̣̠̦̟̒̔̕ ˾̡̒ ̨̖̤̇̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ʕ
 

˥˟ˣ ˴̠̟̟̖̥̟̘̔̚ ̥̠ ˺̞ ̘̖̣̪̒ ̠̟ ̒ ̖̈̓ ˾̡̒ ̧̖̣̖̣̄ ˙̈˾̄̊ 
1. Open the file from Exercise 3 .  

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Oxford.dgn  
or   

OBM -  з\ Bridge \ Base_Models \  SB_CB_1234_1234_Oxford.dgn  

ˣ ˟ Turn off the background map . 

ˤ ˟ Open the Raster Manager , click on File > Attach > WMS  

˥ ˟ Browse to CT_Configuration \ Organization \ Seed \ GCS\  

˦ ˟ Double click on  Ortho_2023_EPSG_2234.xwms  to o pen , select Attach  

Note:  This will load an image of the entire state.  It may take s ome time for this image  to 
come in to view as it is bringing a large amount of data . The view will be slow  to ent irely 
update , because  of this attaching individual  SID files ma y be more desirable.  There are 
other x wms file s available for use in this folder  as well . 

 
˷̘̦̣̖̚ ˧  l˞ ˲ ̥̥̙̒̔ ̤̥̖̣̃̒ ̡̥̠̟̤̀̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˥
 

˥˟ˤ ˲̥̥̙̟̘̒̔̚ ˺̞̘̖̣̪̒ ̗̣̠̞ ̤̥̖̣̃̒ ˷̝̖̤̚ 
A DGN file will be used as a container for the Orthophotography raster attachments.  No other 
̥̖̞̤̚ ˙̝̟̖̚ ̨̠̣̜˝ ̖̝̝̤̔˝ ̥̖̩̥˝ ̖̥̔з˚ ̤̙̝̝̒ ̖̓ ̖̒̕̕̕ ̥̠ ̥̙̤̚ ̗̝̖̚ ̡̖̥̒̔̔ ̗̠̣ ̥̙̖ ̣̤̥̖̣̒ 
attachments.   This container DGN file can be referenced into other Design, D rawing, and Sheet 
Models as needed. Following this simple procedure will be extremely helpful to other units that 
are referencing your files.  There have been several help inquiries on raster referencing through 
the years going back to V8i and continuing in  CONNECT Edition. AEC has found that setting up 
̪̠̦̣ ̣̤̥̖̣̒Я̤ ̟̚ ̒ ̡̤̖̣̥̖̒̒ ̘̟̕ ̙̤̒ ̧̤̠̝̖̕ ̡̦̝̤̙̟̘̓̚̚˝ ̡̣̟̥̟̘̚̚ ̟̒̕ ̠̥̙̖̣ ̨̠̟̤̥̣̖̞̒̕ ̤̤̦̖̤̚˟ 

In this exorcise we will be attaching information from UCONN :  
˴̅ ˲̖̣̝̒̚ ˺̞̘̖̣̪̒ ̟̒̕ ˽̣̒̚̕ ˶̧̝̖̥̠̟̒̚ ˵̨̠̟̝̠̒̕ ˲̡̡ 

¶ CONNECT Edition Products are now compatible with 4 band orthoimage (MrSID4).  
¶ UCONN uses  NAD 83. The DGN container file will be NAD  83 and will be projected as 

needed in your files used for design and layout.  
¶ The downloaded data will be in a Zip file and should be extracted to the  Share  folder in 

your Workset.  Typically, there are two types of Images available  depending on the year 
selected on UCONN Я̤ ̤̥̖̚, Tiffs and SIDs .  ˺ ̥Я̤ important that all the files in the Zip be 
copied into the Share folder  together . 

1. In File Explorer browse to your ̡̛̣̠̖̥̔Я̤ ̙̣̖̄̒ ̗̠̝̖̣̕˟  Click on the Oxford Folder .  Notice the 
Downloaded data from UCON NЯ̤ ̤̥̖̚˟ 

2. In CAD c reate a 2D DGN file  using a 2D Seed file  and use it as a container for the 
Orthophotography raster attachments  and store it in the Share  folder.  

ORD -  з\ Share \ HW_CB_1234_1234 _ Oxford _Raster_Container .dgn  
or  

OBM -  з\ Share \ SB_CB_1234_1234 _ Oxford _Raster_Container .dgn   

Use the 2D seed file:  
CT_Configuration \ Organization \ Seed \ GSC\ 2D_NAD83FT_NAVD88.dgn  

3. After the file is created c heck to make sure the CT NAD 83 Geospatial Header is attached.  

 
˷̘̦̣̖̚ ˧ s˞ ˴ ̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ̖̥̥̟̘̤̄̚ 

https://experience.arcgis.com/experience/f884c9fd806b4a3e8f464f0c5991bb65/


̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˦
 

4. Now you will need to check your user settings. Select  File > Settings > User > Preferences . 

5. On the Preferences Dialog box locate and select  Raster Manager  and under Georeference  
check the following : 
Sister File Settings:  
Use Sister Georeferenced File  is toggled on . 
Save Location Information  is toggled on . 
 
Default Unit Settings:  
Sister File: 1 Unit = 1 US Survey Feet  
Raster file: 1 Unit = 1 Us Survey Feet  
Use Unit Definition Geokey if Present (override PCS unit) is toggle on . 

 
˷̘̦̣̖̚ ˧ˣ˞  ̆ ̤̖̣ ̣̖̗̖̣̖̟̖̤́̔ ̤̥̖̣̃̒ ˾̟̘̖̣̤̒̒ ̖̥̥̟̘̤̄̚ 

6. Click OK. 

7. Select the  Home  tab and hold down the  Attach Tools  icon, select  Raster Manager . 

 
˷̘̦̣̖̚ ˧  ʕ˞ ̃ ̤̥̖̣̒ ˾̟̘̖̣̒̒ ̥̠̠̝ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˧
 

8. In the  Raster Manager  select File / Attach  /  Raster  and  browse to Share/Oxf ord  attach the 
.tif or the sid file. 

̙̖̅ ̞̟̒̚ ̗̗̖̣̖̟̖̤̔̕̚ ̨̖̥̖̖̟̓ ˟̤̚̕ ̟̒̕ ˟̥̗̗̚ ̗̝̖̤̚ ̣̖̒ ̥ ̙̖ ̤̫̖̚ ˫
¶ ˴̡̠̞̣̖̤̤̠̟̚˫ ˟̤̚̕ ̗̝̖̤̚ ̦̤̖ ˾̦̝̥̚˞̣ ̖̤̠̝̦̥̠̟̚ ̖̞̝̖̤̤̄̒ ˺̞̘̖̒ ˵̥̤̖̒̒̓̒ ˙˾̣̄˺˵˚ 
̡̠̞̣̖̤̤̠̟̔̚˝ ̨̙̝̖̚ ˟̥̗̗̚ ̗̝̖̤̚ ̠̕ ̟̠̥˟ 

¶ ̠̣̥̝̥̪́̒̓̚̚˫ ˟̤̚̕ ̗̝̖̤̚ ̣̖̒ ̖̤̘̟̖̕̚̕ ̥̠ ̖̟̝̖̒̓ ̡̠̣̥̝̥̪̒̓̚̚ ̠̗ ̧̞̤̤̖̒̚ ̥̓̚˞̞ ̡̡̖̒̕ ˙̣̤̥̖̣̒˚ 
̞̘̖̤̒̚˝ ̨̙̝̖̚ ˟̥̗̗̚ ̗̝̖̤̚ ̠̕ ̟̠̥ ̡̤̖̗̝̝̪̔̔̒̚̚ ̣̖̤̤̒̕̕ ̡̠̣̥̝̥̪̒̓̚̚˟ 

9. On the Raster Attach Options dialog box under Geometry select  Attach ment . Select the 
Attach  button to accept.  

 
˷̘̦̣̖̚ ˧  ˥˞ ̃ ̤̥̖̣̒ ˾̟̘̖̣̒̒ ˲̥̥̙̞̖̟̥̒̔ ̖̥̥̟̘̤̄̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˨
 

10. Select  Fit , to bring the photo to the center of the view  and Save Settings . 

 
˷̘̦̣̖̚ ˧  ˦˞ ̇ ̨̖̚ ̠̗ ̤̥̖̣̃̒ ˺̞̘̖̒ 

ˢˢ˟ ˺̗ ̪̠̦ ̨̠̦̝̕ ̝̜̖̚ ̥̙̖ ̤̥̖̣̃̒ ̥̠ ̦̤̖ ̡̣̟̤̣̖̟̪̅̒̒̔˝ ̤̖̝̖̥̔ ̥̚ ̟̚ ̥̙̖ ̨̖̇̚ ̨̟̠̈̚̕ ̒ ̟̕ ̟̚ 
̡̣̠̖̣̥̖̤́̚ ̦ ̟̖̣̕ ˸̖̟̖̣̝̒ ̤ ̖̥ ̥̙̖ ̖̤̣̖̕̚̕ ̡̣̟̤̣̖̟̪̅̒̒̔ ̧ ̝̦̖̒ ˟

 
˷̘̦̣̖̚ ˧  ˧Ь ̄ ̖̥ ̡̣̟̤̣̖̟̪̅̒̒̔ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˩
 

11. Open the File from Exercise 3 .  

ORD -  з\ Highways \ Base_Models \ HW_CB_1234_1234_Oxford.dgn  
or  

OBM - з\ Bridge \ Base_Models \  SB_CB_1234_1234_Oxford.dgn  

12. Turn off the background map  and the in the Raster Manager turn off the WMS  in View 1 . 

13. Reference this file in  using Geograpgh ic -  reprojected . Notice the reference lines up with 
the NAD 27 Survey File.  

 
˷̘̦̣̖̚ ˧ ˨˞ ̃ ̖̗̖̣̖̟̖̔ ˸̡̖̠̘̣̙̒̔̚ ̡̛̖̣̠̖̥̖̃̔̕ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˥  ˪
 

Exercise 5   -  Creating a Terrain from LiDAR Data  
 

Statewide LiDAR can be found on the UCONN/CT ECO Website. CONNECT Edition Products are now 
compatible the LAS data.  

For information please visit:  
˴̅ ˲̖̣̝̒̚ ˺̞̘̖̣̪̒ ̟̒̕ ˽̣̒̚̕ ˶̧̝̖̥̠̟̒̚ ˵̨̠̟̝̠̒̕ ˲̡̡ 

UCONN uses NAD 83. The DGN container file will be NAD 83 and will be projected as needed in your 
files used for design and layout.  

¶ The downloaded data will be in a Zip file and should be extracted to the  Share  folder in your 
Workset.  

LiDAR data comes in two main formats: LAS and LAZ. LAS is an uncompressed format ideal for fast 
processing, while LAZ is a compressed version that saves up to 90% of storage space without 
losing data accuracy. Here's what you need to know:  

¶ LAS: Faster to process, widely used for active workflows, but requires more storage.  
¶ LAZ: Smaller file size, great for storage and sharing, but slower to process due to 

decompression.  

The most recent  available data  form UCONN only provided the LAZ format, which is unfor tunate for 
us in the CAD world as this causes us to have to process a few extra step s to get a terrain.  

 
This Module will introduce two ways to import TOPO Data:  
¶ ̖̣̣̟̅̒̚ ̗̣̠̞ ˽˲̄ ˷̝̖̚ 
¶ ̖̣̣̟̅̒̚ ̗̣̠̞ ˽˲ ̋˷ ̝̖̚ 
¶ ̖̣̣̟̅̒̚ ̗̣̠̞ ˶̤̣̚ 

 

https://experience.arcgis.com/experience/f884c9fd806b4a3e8f464f0c5991bb65/
https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/creating-a-terrain-from-lidar-data?language=en_US#Terrain%20from%20Esri


̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  l
 

˦˟ˢ ̖̣̣̟̅̒̚ ̗̣̠̞ ˽˲̄ ˷̝̖̚ 

˦˟ˢ˟ˢ ˺̡̞̠̣̥ ̨ ̥̙̚ ˷̝̥̖̣̟̘̚̚ 

1. In CAD create a 3D DGN file  using a 3D Seed file  and use it as a container for the LAS 
Terrain  and store it in the Share  folder.  

ORD -  з\ Share \ HW_ NC_1234_1234_Oxford_TerrainFromLAS.dgn   
or  

OBM -  з\ Share \ SB_ NC_1234_1234_Oxford_TerrainFromLAS.dgn  

Use the 3D seed file:  
CT_Configuration \ Organization \ Seed \ GSC\ 3D_NAD83FT_NAVD88.dgn  

 
˷̘̦̣̖̚ ˧  ˩˞ ˴ ̣̖̥̖̒ ˿̨̖ ˷̝̖̚ 

2. Check to make sure the CT NAD 83  / NAVD88  Geospatial Header is attached.  

 
˷̘̦̣̖̚ ˧  ˪˞ ˴ ̠̠̣̟̥̖̒̕̚ ̪̤̥̖̞̄ ̖̥̥̟̘̤̄̚  

3. ORD Ь Select the  OpenRoads Modeling  or Survey  Workflow , on the  Terrain  tab , Create  
section , select the  From File  icon.  

 
˷̘̦̣̖̚ ˨ l̀̃  ˵˺ ̡̞̠̣̥ ̒ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˷̣̠̞ ˷̝̖̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦ s
 

OBM Ь Select the  OpenBridge Modeler  Workflow , on the Civil  tab, Terrain Model  
section , select the top left pull down and choose Create From File .  

   
˷̘̦̣̖̚ ˨ sЬ ̀ ˳˾ ˺̞ ̡̠̣̥ ̒ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˷̣̠̞ ˷̝̖̚ 

4. Browse to the downloaded  LAS file(s) in Share / Oxford . Select the LAS file(s)  
885720_ne  and 885720_nw and click on the  Done  button.  

 
˷̘̦̣̖̚ ˨ x˞ ̄ ̖̝̖̥̔ ˷̝̖̤̚ ̥̠ ˺̡̞̠̣̥ ˵̝̠̘̒̚ ˳̠̩ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  x
 

5. In the Import Terrain Model(s) s elect the following : 

a. On the Import Terrain Model(s) dialog box only leave  only Ground  checked on  for 
both Terrains . In the file Option area s elect the Feature Definition  Terrain \ Existin g 
Contours Only .  

b. Under File Options the number of points and size of the file can be reduced by Filtering. 

Three options are supported: None , Tile , and Tin . From empirical studies, the tiling 

algorithm is faster and typically produces a 30% to 50% reduction in file size. The TIN 

algorithm typically produces a 70% to 90% reduction.  

c. ˺̟ ̥̙̖ ̗̝̥̖̣̚ ̣̖̒̒ ̤̖̝̖̥̔˫  ˷̚ ̝̥̖̣˫ ̟̅̚    ̋ ̠̝̣̖̟̖̅̒̔˫ ˢ    ˸̣̟̦̝̣̥̪̒̒̚˫ ˴̠̣̤̖̒ 

d. Select  Import  and  Close  the dialog box.  

 
˷̘̦̣̖̚ ˨ ʕЬ ˺ ̡̞̠̣̥ ̖̣̣̟̅̒̚ ̖̝̖̥̠̟̄̔̚ ̤



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ʕ
 

˿̠̟̖  -  No filter is applied if None is selected. No additional inputs are required.  

̝̖̅̚ -  The tiling algorithm is a recursive divide and conquer algorithm that divides the data 
set into tiles. A best fit plane is calculated for each tile and points are removed if they fall 
within the user set Z tolerance to the plane . 

Z Tolerance  The variation in the Z coordinate that the surface is allowed to move during the 
filtering process. Typically for the first invocation of the filtering function, the Z 
tolerance should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 0.5 for 
metric data sets. Depending on the outcome and desired result, the Z tolerance can 
be varied up or down.  

Minimum 
Tile Points  

A tile will not be subdivided if it has less than this number of points. Typically set this 
to five.  

Max Tile 
Divisions  

Allowable level of recursion allowed and is the number of times the initial tiling set 
can be subdivided. Typically set this to five.  

Start Tile 
Length  

The data set is initially divided into tiles of this size, prior to recursion to the minimum 
tile points. The setting of this parameter requires some knowledge of the distance 
between the points, which requires an inspection of the points in MicroStation t o 
determine. Typically set this to 10 times the distance between the points.  

̅̚ ̟- The TIN algorithm filters points if they fall within the user set Z tolerance of the triangle planes. 

The TIN algorithm first tiles the points into tiles with a maximum of 2 million points and then 

repetitively triangulates each tile filtering out points.  

Z Tolerance The variation in the Z coordinate that the surface is allowed to move during the filtering 

process. Typically for the first invocation of the filtering function, the Z tolerance 

should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 0.5 for metric data 

sets. Depending on the outcome and desired result, the Z tolerance can be varied up or 

down. 

Granularity Course - Filters more points with some blurring of ridges and valleys. Fine - Filters 

fewer points with less blurring of ridges and valleys. 

Reinsert 

Points 

After filtering the points a further check is made based on the tolerances  

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˥
 

˦˟ˢ˟ˣ ˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

ˢ˟ ˺̟ ˶̡̩̝̠̣̖̣ ̤ ̖̝̖̥̔ ̥̙̖ ̨̥̠ ̖̣̣̟̤̅̒̚ ̒ ̟̕ ̨̤̥̙̔̚ ̥̙̖ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̤̚̚̚ ̥̠ ˶̩̤̥̟̘̚̚ 
˸̣̠̦̟̕˟ ̙̤̅̚ ̨̝̝̚ ̤̖̥ ̥̙̖ ̖̣̣̟̅̒̚ ̥̠ ̠̟̝̪ ̤̖̖ ̥̙̖ ˳̠̦̟̣̪̒̕ ̨̙̙̔̚ ̨̝̝̚ ̞̜̖̒ ̤̚ ̖̤̖̣̒̚ ̥̠ ̤̖̖ 
̥̙̖ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ̨̖ ̨̝̝̚ ̖̓ ̣̖̥̟̘̔̒̚ ̟̚ ̥̙̖ ̟̖̩̥ ̡̤̥̖˟ 

 
˷̘̦̣̖̚ ˨ ˥Ь ̆ ̡̥̖̒̕̕ ̖̣̣̟̅̒̚ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚ 

ˣ ˟ ̀̃˵ Ь ̖̝̖̥̄̔ ̥̙̖ ̡̖̟̠̤̀̃̒̕ ˾̠̖̝̟̘̕̚ ̠ ̣ ̧̦̣̖̪̄ ̨̠̣̜̗̝̠̈˝ ̟̚ ̥̙̖ ̖̣̣̟̅̒̚ ̥ ̒̓, Create  
section , select the  Additional Methods pull down and choose  ˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ 
˾̠̖̝̕.  

 
˷̘̦̣̖̚ ˨ ˦Ь ̀ ̃˵ ˴̣ ̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

̀˳˾ Ь ̖̝̖̥̄̔ ̥̙̖ ̡̖̟̀˳̣̘̖̚̕ ˾̠̖̝̖̣̕ ̨̠̣̜̗̝̠̈˝ ̟̚ ̥̙̖ ˴̧̝̚̚ ̥̒̓̋ ̖̅ ̣̣̟̒̚ ˾̠̖̝̕ 
̤̖ ̥̠̟̔̚ ̤̋ ̖̝̖̥̔ ̥̙̖ ̡̥̠ ̝̖̗̥ ̡̦̝̝ ̕ ̨̠̟ ̟̒̕ ̙̠̠̤̖̔ ˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˟

 
˷̘̦̣̖̚ ˨ ˧Ь ̀ ˳˾ ˴̣ ̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˦
 

̖̄ ̝̖̥̔ ̥̙̖ ˩˩˦˨ˣˡ̟̖̐ ̟̒̕ ̝̔ ̜̔̚ ̥ ̙̖ ˲̕ ̓̕ ̦̥̥̠̟ 
̤̖̝̖̥̔ ̥̙̖ ˩˩˦˨ˣˡ̨̟̐ ̒ ̟̕ ̝̜̔̔̚ ̥̙̖ ˲̕ ̓̕ ̦̥̥̠̟ 
̤̖̆ ̥̙̖ ̨̗̠̝̝̠̟̘̚ ̤̖̥̥̟̘̤̚˫ 
˴̦̣̣̖̟̥ ˲̥̠̟̔̚ ˫˲̡̡̖̟̕ 
̖̣̣̟̅̒̚ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚ ˫̅ ̖̣̣̟̒̚ ˯ ˶̩̤̥̟̘̚̚ ˴̠̟̥̠̦̣̤ ̟̝̪̀ 
˿̞̖̒ ˫˴ ̠̞̟̖̓̚̕ 

˴̝̜̔̚ ˷̟̤̙̚̚ ̥ ̠ ̡̠̞̝̖̥̖̔ ̥̙̖ ˴̠ ̡̞̝̖̩ ̖̣̣̟̅̒̚ ˟

     
˷̘̦̣̖̚ ˨ ˨Ь ˴ ̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

˴̦̣̣̖̟̥ ˲̥̠̟̔̚ ˾̖̣̘̟̘̚ ̠̣ ˲̡̡̖̟̟̘̕̚ ̅ ̖̣̣̟̒̚ ˾ ̠̖̝̤̕ 
˳̠̥̙ ̞̖̣̘̟̘̚ ̟̒̕ ̡̡̖̟̟̘̒̕̚ ̠̞̟̖̤̔̓̚ ̥̙̖ ̥̒̒̕ ̠̟̥̟̖̔̒̚̕ ̟̚ ̡̞̦̝̥̝̖̚ ˙̨̥̠ ̠̣ ̞̠̣̖˚ 
̞̠̖̝̤̕˟ ˹̨̧̠̖̖̣˝ ̥̙̖̪ ̣̖̒ ̟̠̥ ̥̙̖ ̤̞̖̒ ̡̣̠̖̤̤̔ ̟̒̕ ̪̖̝̚̕ ̗̗̖̣̖̟̥̕̚ ̣̖̤̦̝̥̤˟ 

̙̖̟̈ ̡̡̖̟̟̘̒̕̚˝ ̥̙̖ ̨̤̠̗̥̣̖̒ ̥̣̟̘̦̝̥̖̤̒̒̚ ̥̙̖ ̠̞̟̖̔̓̚̕ ̥̒̒̕ ̗̣̠̞ ̥̙̖ ̨̥̠ ̥̖̣̣̟̒̚ ̞̠̖̝̤̕ 
̦̤̟̘̚ ̝̝̒ ̥̒̒̕ ̗̣̠̞ ̠̥̙̓ ̞̠̖̝̤̕ ̟̒̕ ̘̟̠̣̟̘̚̚ ̟̠̟̖˟ ̙̖̅ ̨̥̠ ̞̠̖̝̤̕ ̞̪̒ ̧̡̠̖̣̝̒ ̠̣ ̖̓ 
̛̖̟̥̒̒̔̕ ̥̠ ̠̟̖ ̟̠̥̙̖̣̒˟ ˺̗ ̥̙̖̣̖ ̤̚ ̥̒̒̕ ̟̚ ̠̥̙̓ ̞̠̖̝̤̕ ̟̚ ̒ ̠̞̞̠̟̔ ̣̖̒̒˝ ̥̚ ̤̚ ̝̝̒ ̦̥̝̫̖̚̚̕ 
̗̠̣ ̥̣̟̘̦̝̥̠̟̒̒̚̚˟ 

̙̖̟̈ ̞̖̣̘̟̘̚˝ ̥̙̖ ̨̤̠̗̥̣̖̒ ̥̣̟̘̦̝̥̖̤̒̒̚ ̥̙̖ ̠̞̟̖̔̓̚̕ ̥̒̒̕ ̗̣̠̞ ̥̙̖ ̨̥̠ ̥̖̣̣̟̒̚ ̞̠̖̝̤̕ ̟̚ 
̣̖̤̒̒ ̨̙̖̣̖ ̥̙̖̪ ̠̕ ̟̠̥ ̧̡̠̖̣̝̒˟ ̙̖̅ ̨̥̠ ̞̠̖̝̤̕ ̞̦̤̥ ̧̡̠̖̣̝̒ ̥̒ ̝̖̤̥̒ ̠̟̖ ̡̠̟̥̚˟ ˺̗ ̥̙̖̣̖ ̤̚ 
̥̒̒̕ ̟̚ ̠̥̙̓ ̞̠̖̝̤̕ ̟̚ ̒ ̠̞̞̠̟̔ ̣̖̒̒ ˙̧̡̠̖̣̝̒˚˝ ̥̙̖ ̥̒̒̕ ̗̣̠̞ ̥̙̖ ̡̣̞̣̪̒̚ ̞̠̖̝̕ ̤̚ 
̤̣̖̔̒̕̚̕̕˝ ̟̒̕ ̠̟̝̪ ̥̙̖ ̥̒̒̕ ̗̣̠̞ ̥̙̖ ̞̖̣̘̟̘̚ ̞̠̖̝̕ ̤̚ ̦̤̖̕˟ ̙̖̣̖̗̠̣̖̅˝ ̠̣̖̣̕ ̤̚ ̣̥̝̔̔̒̚̚˟ 

 
˷̘̦̣̖̚ ˨ ˩˞ ˾ ̖̣̘̟̘̚ ̧ ̤˲ ̡̡̖̟̟̘̕̚ ̖̣̣̟̅̒̚ ˾̠̖̝̤̕ 

˺̟ ̥̙̖ ̡̖̩̞̝̖̒ ̧̠̖̒̓˝ ̅˾ˢ ̤̚ ̥̙̖ ̡̣̞̣̪̒̚ ̞̠̖̝̕˝ ̟̒̕ ̅˾ˣ ̤̚ ̖̟̘̓̚ ̞̖̣̘̖̕ ˙̨̝̠̖̣ ̠̟ ̥̙̖ 
̠̣̖̣̕ ̝̤̥̚˚˟ ˺̟ ̥̙̖ ̤̙̖̒̕̕ ̣̖̒̒ ˙̨̙̙̔̚ ̠̥̙̓ ̥̖̣̣̟̒̚ ̞̠̖̝̤̕ ̧̙̖̒ ̟̚ ̠̞̞̠̟̔˚˝ ̥̙̖ ̥̒̒̕ ̗̣̠̞ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˧
 

̅˾ˣ ̤̚ ̦̥̝̫̖̚̚̕˝ ̟̒̕ ̣̖̥̣̟̘̦̝̥̖̒̒̚̕ ̣̠̦̟̒̕ ̥̙̖ ̠̞̞̠̟̔ ̖̘̖̤̕˟ ̙̖̅ ̥̒̒̕ ̨̥̙̟̚̚ ̥̙̖ ̤̙̖̒̕̕ 
̣̖̒̒ ̗̣̠̞ ̅˾ˢ ̤̚ ̤̣̖̔̒̕̚̕̕˟ ̙̖̅ ̙̦̝̝ ̠̗ ̥̙̖ ̨̟̖˝ ̞̖̣̘̖̕ ̥̖̣̣̟̒̚ ̞̠̖̝̕ ̤̚ ̨̤̙̠̟˟ 

ˢ˟ ˺̟ ̠̦̣ ̡̖̩̞̝̖̒ ̥̙̖ ̗̝̖̤̚ ̠̕ ̟̠̥ ̧̡̠̖̣̝̒ ̤̠ ˲̡̡̖̟̕ ̚ ̤ ̟̖̖̖̕̕˟ ˿̠̥̖̔̚ ̨̙̠ ̥̙ ̖̠̟̥̠̦̣̤̔ 
̣̖̥̒̔ ̥̠ ̥̙̖ ̨̥̠ ̗̗̖̣̖̟̕̚ ̥˾ ̖̥̙̠̤̕˟ 

 
˷̘̦̣̖̚ ˨ ˪Ь ˴ ̠̟̥̠̦̣ ˵̡̤̝̪̒̚ ̗̥̖̣̒ ̒ ˴̡̠̞̝̖̩ ˾̖̣̘̖̕ ̖̣̣̟̅̒̚ 

 

 
˷̘̦̣̖̚ ˩  l˞ ˴ ̠̟̥̠̦̣ ˵̡̤̝̪̒̚ ̗̥̖̣̒ ̒ ˴̡̠̞̝̖̩ ˲̡̡̖̟̖̕̕ ̅ ̖̣̣̟̒̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˨
 

˦˟ˢ˟ˤ ˴̣̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

ˢ˟ ˺̟ ˲̥̥̣̦̥̖̤̓̚ ̤̖̥ ̥̙̖ ̗ ̨̠̝̝̠̟̘̚ ̧̥̖̒̔̚ ˫
˽̧̖̖̝˫  ˶̐̅˶̃̃˲˺˿̐˳̠̦̟̣̪̒̕ 
˴̠̝̠̣ ˫̨̖̝̝̠̊ 
˽̟̖̚ ̥̪̝̖̄ ˫ʕ 
˽̟̖̚ ̖̘̙̥̈̚ ˫s  l

 
˷̘̦̣̖̚ ˩ sЬ ̄ ̖̥ ˲̥̥̣̦̥̖̤̓̚ 

ˣ ˟ ̤̆ ̟̘̚ ̥̙̖ ̨̣̟̘̒̕̚ ̥̠̠̝ˬ ̝̖́̒̔ ̡̙̖̄̒˝ ̨̣̒̕ ̒ ̝̠̤̖̔̕ ̡̠̝̪̘̠̟ ̣̠̦̟̒̕ ̥̙̖ ̖̣̣̟̅̒̚ ̪̠̦ 
̨̠̦̝̕ ̝̜̖̚ ̥̠ ̡̜̖̖˟ 

 
˷̘̦̣̖̚ ˩ xЬ ̄ ̖̥ ˽̧̖̖̝ ˲̧̥̖̔̚ ̟̒̕ ̝̖́̒̔ ̡̙̖̄̒ 

ˤ ˟ ˺̟ ˶̡̩̝̠̣̖̣ ̤ ̖̝̖̥̔ ̥̙̖ ˴̠̞̟̖̓̚̕ ̖̅ ̣̣̟̤̒̚ ̒ ̟̕ ̨̤̥̙̔̚ ̥̙̖ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̤̚̚̚ ̜̓̒̔ 
˶̩̤̥̟̘̚̚ ˸̣̠̦̟̕˟ ̙̅ ̤̚ ̨̝̝̚ ̤̖̥ ̥̙̖ ̖̣̣̟̅̒̚ ̥̠ ̠̟̝̪ ̤̖̖ ̥̙̖ ˳̠̦̟̣̪̒̕ ̨̙̙̔̚ ̨̝̝̚ ̞̜̖̒ ̤̚ 
̖̤̖̣̒̚ ̥̠ ̤̖̖ ̥̙̖ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ̨̖ ̨̝̝̚ ̖̓ ̣̖̥̟̘̔̒̚ ̟̚ ̥̙̖ ̟̖̩̥ ̡̤̥̖˟ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˩
 

˥ ˟ ̀̃˵ ˞ ̖̝̖̥̄̔ ̥̙̖ ̡̖̟̠̤̀̃̒̕ ˾̠̖̝̟̘̕̚ ̠ ̣ ̧̦̣̖̪̄ ̈ ̨̠̣̜̗̝̠˝ ̟̚ ̥̙̖ ̖̣̣̟̅̒̚ ̥̒̓ , Create  
section , select Additional Methods pull down and choose  ˴̣̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕.  

 
˷̘̦̣̖̚ ˩ ʕЬ ̀ ̃˵ ˴̣ ̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

̀˳˾ ˞ ̖̝̖̥̄̔ ̥̙̖ ̡̖̟̀˳̣̘̖̚̕ ˾̠̖̝̖̣̕ ̨̠̣̜̗̝̠̈˝ ̟̚ ̥̙̖ ˴̧̝̚̚ ̥̒̓˝ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ̤̖ ̥̠̟̔̚ ̋
̤̖̝̖̥̔ ̥̙̖ ̡̥̠ ̝̖̗̥ ̡̦̝̝ ̨̠̟̕ ̟̒̕ ̙̠̠̤̖̔ ˴̣̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕˟ 

 
˷̘̦̣̖̚ ˩  ˥Ь ̀ ˳˾ ˴̣ ̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

ˣ ˟ ̖̄ ̥ ̤̒ ̨̗̠̝̝̠̤ ˫
̖̗̖̣̖̟̖̃̔̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ˫˴̠̞̟̖̓̚̕ 
˴̡̡̝̟̘̚̚ ˾̖̥̙̠̕˫ ˶̩̥̖̣̟̝̒ 
˿̠ ˹̠̣̫̠̟̥̝̒̚ ̠̣ ̖̣̥̝̇̔̒̚ ̗̗̤̖̥̀ 
˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚˫ ̖̣̣̟̅̒̚ ˯ ˶̩̤̥̟̘̚̚ ˴̠̟̥̠̦̣̤ ̟̝̪̀ 
˿̞̖̒˫ ˴̡̡̝̖̚̕ 

 

˷̘̦̣̖̚ ˩  ˦˞ ˴ ̣̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ 
˾̠̖̝̕ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˦  ˪
 

ˤ ˟ ˷̨̠̝̝̠ ̥̙̖ ̡̡̣̠̞̥̤ˬ ̤̖̝̖̥̔ ̥̙̖ ˴̡̡̝̟̘̚̚ ˶̝̖̞̖̟̥ ̟̒̕ ̣̖̤̖̥ ˙̣̘̙̥̚ ˴̝̜̔̚˚ ̨̙̖̟ ̠̟̖̕˝ 
̥̠̘̘̝̖ ̥̙̣̠̦̘̙ ̥̙̖ ̤̖̥̥̟̘̤̚ ̟̒̕ ̡̝̔̚ ̥̙̖ ̖̣̣̟̅̒̚˟ 

 

 
˷̘̦̣̖̚ ˩  ˧Ь ˽ ̠̥̖̔̒ ˴̡̡̝̟̘̚̚ ˶̝̖̞̖̟̥ 

 
˥ ˟ ̖̝̖̥̄̔ ̥̙̖ ˴̡̡̝̟̘̚̚ ̡̙̖̄̒ ̟̒̕ ̖̥̕̚ ̥̙̖ ̡̤̙̖̒ ̤̒ ̟̖̖̖̕̕ ˟

 
˷̘̦̣̖̚ ˩ ˨˞ ˾ ̧̠̖ ̠̟̥́̚ ̠̟ ̡̙̖̄̒ 

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  l
 

 
˷̘̦̣̖̚ ˩  ˩˞ ˺ ̟̤̖̣̥ ̠̟̥́̚ ̠̟ ̡̙̖̄̒ 

˦ ˟ ˺̟ ˶̡̩̝̠̣̖̣ ̣̘̙̥̚ ̝̜̔̔̚ ̠̟ ̥̙̖ ˴̡̡̝̖̚̕ ̥̖̣̣̟̒̚ ̟̒̕ ̤̖ ̝̖̥̔ ̖̥̄ ̤̒ ˲̧̥̖̔̚ ̖̣̣̟̅̒̚ ˟

 
˷̘̦̣̖̚ ˩  ˪Ь ̄ ̖̥ ˲̧̥̖̔̚ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧ s
 

˧ ˟ ˺̗ ̪̠̦ ̧̙̖̒ ̟̪̒ ̠̟̥̠̦̣̔ ̤̠ ̦̥̤̖̚̕ ̠̗ ̥̙̖ ˳̠̦̟̣̪̒̕˝ ̨̤̥̙̔̚ ̥ ̙̖ ˶̘̖̕ ˾̖̥̙̠̕ ̥̠ ̧̝̖̣̄̚ ˟

 
˷̘̦̣̖̚ ˪  lЬ ˶ ̘̖̕ ˾̖̥̙̠̕ ̧̝̖̣̄̚ 

˨˟ ̧̖̄̒ ̖̥̥̟̘̤̄̚ ˟
 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  x
 

˦˟ˣ ̖̣̣̟̅̒̚ ̗̣̠̞ ˽˲̋ 
̤̟̘̆̚ ̒ ˽˲̋ ̗̝̖̚ ̨̝̝̚ ̢̣̖̦̣̖̚ ̦̤̖̣̤ ̥̠˫  
̡̥̖̄ ˢ˟ ˴̣ ̖̥̖̒ ̒ ̠̟̥́̚ ˴̝̠̦̕ ˙́̀˵ ̗̝̖̚˚ ̗ ̣̠̞ ̥̙̖ ˽˲̋ ̥̒̒̕ ˟
̡̥̖̄ ˣ˟ ˷̚ ̝̥̖̣ ̥̙̖ ̠̟̥́̚ ˴̝̠̦̕ ̥̠ ̛̦̤̥ ̡̤̝̪̒̕̚ ̥̙̖ ̘̣̠̦̟̕ ̡̠̟̥̤̚ ̠̇ ̥̙̖̣ ̝̤̤̗̥̠̟̔̒̔̒̚̚̚ ̤ ̦̙̔ ̤̒ 

̖̘̖̥̥̠̟̇̒̚˝ ̟̒̕ ̦̟̝̤̤̗̖̔̒̚̚̕ ̨̝̝̚ ̟̖̖̕ ̥̠ ̖̓ ̥̦̣̟̖  ̠̕ ̗̗˚ 
̡̥̖̄ ˤ˟ ˺̞ ̡̠̣̥ ̥̙̖ ̠̟̥́̚ ˴̝̠̦̕ ̟̥̠̚ ̒ ̖̅ ̣̣̟̒̚ 

˦˟ˣ˟ˢ ˴̣̖̥̖̒ ̒ ̠̟̥́̚ ˴̝̠̦̕ 

1. In CAD create a 3D DGN file  using a 3D Seed file  and use it as a container for the LAS 
Terrain and store it in the Share  folder.  

ORD -  з\ Share \ HW_ NC_1234_1234_Oxford_TerrainFromLA Z.dgn   
or  

OBM -  з\ Share \ SB_ NC_1234_1234_Oxford_TerrainFromLA Z.dgn  

Use the 3D seed file:  
CT_Configuration \ Organization \ Seed \ GCS\ 3D_NAD83FT_NAVD88.dgn  

ˣ ˟ ˺̟ ̖̣̙̄̒̔ ̥ ̡̪̖ ̠̟̥́̚ ˴̝̠̦̤̕ ̟̒̕ ̤̖̝̖̥̔˝ ̥̙̤̚ ̨̝̝̚ ̣̟̘̓̚ ̡̦ ̥̙̖ ̠̟̥́̚ ˴̝̠̦̤̕ ̝̠̘̒̕̚ ̠̩̓ ˟

ˤ ˟ ̖̝̖̥̄̔ ˷̝̖̚ ˯ ˲̥̥̙̒̔ 

 
˷̘̦̣̖̚ ˪ sЬ ˲ ̥̥̙̒̔ ̠̟̥́̚ ˴̝̠̦̤̕ ̝̠̘̒̕̚ ̠̩̓ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ʕ
 

˥ ˟ ˺̟ ̥̙̖ ̡̀ ̖̟ ̝̠̘̒̕̚ ̠̩̓ ̙̟̘̖̔̒ ̥̙̖ ̗̝̖̚ ̡̥̪̖ ̥̠ ˽˲ ̋̒ ̟̕ ̨̣̠̤̖̓ ̥̠ ̙̣̖̄̒ ˯ ̩̗̠̣̀̕ ˯ ˽˲̋ ˯ 
˩˩˦˨ˣˡ̟̖̐˟̝̫̒ 

˦ ˟ ˴̝̜̔̚ ̡̖̟̀˟ 

 
˷̘̦̣̖̚ ˪ xЬ ̀ ̡̖̟ ̠̟̥́̚ ˴̝̠̦̕ ̝̠̘̒̕̚ ̠̩̓ 

˧ ˟ ̠̦̊ ̨̝̝̚ ̖̓ ̡̡̣̠̞̥̖̕ ̥̠ ̣̖̥̖̔̒ ̧̠̟̖̣̥̔ ̥̙̖ ˽˲̋ ̗ ̝̖̚˟ ̄ ̨̥̙̔̚ ̥̙̖ ̤̠̦̣̖̔ ˸̖̠̞̖̥̣̪ ̟̥̆̚ ̥̠ 
̆̄ ̧̦̣̖̪̄ ˷̖̖̥ ̟̒̕ ̝̜̔̔̚ ̀ ˼˟ 

 
˷̘̦̣̖̚ ˪ ʕЬ ˴ ̧̠̟̖̣̥ ˽˲̋ ̝̠̘̒̕̚ ̠̩̓ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˥
 

˨˟ ̠̦̊ ̨̝̝̚ ̖̓ ̡̡̣̠̞̥̖̕ ̥̠ ̧̖̄̒ ̒ ˛̡̠̕ ̗̝̖̚˟ ̧̖̄̒ ̥̚ ̥̠ ̙̣̖̄̒̍̀ ̩̗̠̣̍̕˽ ˲ ̋

 
˷̘̦̣̖̚ ˪  ˥Ь ̄ ̧̖̒ ́̀˵ ̗̝̖̚ ̝̠̘̒̕̚ ̠̩̓ 

ˤ ˟ ̙̖̅ ̗̝̖̚ ̨̝̝̚ ̖̘̟̓̚ ̥̠ ̧̠̟̖̣̥̔ ̟̒̕ ̞̪̒ ̥̜̖̒ ̒ ̨̗̖ ̞̟̦̥̖̤̚ ˟˲̗̥̖̣ ̥̚ ̤̚ ̡̣̠̖̤̤̖̔̕ ̥̙̖ 
̧̠̟̖̣̥̖̔̕ ̥̒̒̕ ̨̝̝̚ ̡̡̖̣̒̒ ̤̒ ̒ ́̀˵ ̗̝̖̚ ̒ ̟ ̨̕ ̝̝̚ ̡̡̖̣̒̒ ̟̚ ̥̙̖ ̠̟̥́̚ ˴̝̠̦̤̕ ̝̠̘̒̕̚ ̠̩̓ ˟

 
˷̘̦̣̖̚ ˪  ˦Ь ́ ̠̟̥̚ ˴̝̠̦̤̕ ̝̠̘̒̕̚ ̠̩̓ 

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˦
 

˦˟ˣ˟ˣ ˷̝̥̖̣̚ ̥̙̖ ̠̟̥́̚ ˴̝̠̦̕ ˴̝̤̒ ̤̗̥̠̟̤̔̒̚̚̚ 

ˢ˟ ˷̥̚ ̨̖̇̚ ˢ ̥ ̠ ̧̨̖̚ ̥̙̖ ̥̒̒̕˟ ˺̟ ̨̖̇̚ ˢ ̖̝̖̥̄̔ ̨̖̇̚ ˲̥̥̣̦̥̖̤̓̚˝ ̤̖̝̖̥̔ ̠̟̥́̚ ˴̝̠̦̕ ̥̪̝̖̤̄˝ ̗̠̣ 
̥̪̖̄ ̤̖̝̖̥̔ ˴̝̤̤̗̥̠̟̒̔̒̚̚̚ ˟

ˣ ˟ ̖̝̖̥̄̔ ̥̙̖ ̥̙̣̖̖ ̠̥̤̕ з ̠ ̟ ̥̙̖ ̣̘̙̥̚ ̠̗ ˴̝̤̤̗̥̠̟̒̔̒̚̚̚˟  ̙̖̅ ̡̣̠̖̣̥̖̤́̚ ̝̠̘̒̕̚ ̠̩̓ ̨̝̝̚ 
̡̤̝̪̒̕̚ ̒ ̝̤̥̚ ̠̗ ˴̝̤̤̗̥̠̟̒̔̒̚̚̚˝ ̥̦̣̟ ̠̗̗ ̧̖̖̣̪̥̙̟̘̚ ̡̖̩̖̥̔ ˸̣̠̦̟̕˝ ̥̙̖ ̧̨̖̚ ̤̙̠̦̝̕ ̨̤̙̠ 
̠̟̝̪ ̣̖̕ ̡̠ ̟̥̤̚ ˟

ˤ ˟ ̦̣̟̅ ̠̟ ̥̙̖ ˳̜̘̣̠̦̟̒̔̕ ˾̡̒ ̥ ̠ ̧̖̣̗̪̚ ̥̚ ̝̟̖̤̚ ̡̦˟ 

 
˷̘̦̣̖̚ ˪  ˧Ь ̇ ̨̖̚ ˲̥̥̣̦̥̖̤̓̚˝ ˴̝̤̤̗̥̠̟̒̔̒̚̚̚ ̡̣̠̖̣̥̖̤́̚ ̀ ˿ˠ̗̗̀ 

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˧
 

˦˟ˣ˟ˤ ˺̡̞̠̣̥ ̒ ̠̟̥́̚ ˴̝̠̦̕ ̟̥̠̚ ̒ ̖̣̣̟̅̒̚ ̨̥̙̚ ˷̝̥̖̣̟̘̚̚ 

1. In Search  type Create from Point Cloud  and select, this will bring up the Create Terrain 
from Point Cloud dia log box.  

2. In the File Option s area select the Feature Definition  Terrain \ Existing Contours Only .  

3. Under File Options the number of points and size of the file can be reduced by Filtering . 

˺̟ ̥̙̖ ̗̝̥̖̣̚ ̣̖̒̒ ̤̖̝̖̥̔˫  ˷̝̥̖̣̚˫ ̟̅̚    ̋ ̠̝̣̖̟̖̅̒̔˫ ˢ    ˸̣̟̦̝̣̥̪̒̒̚˫ ˴̠̣̤̖̒ 

4. Select  Import  and  Close  the dialog box.  

5. Select the Selection tool.  

6. In the Point Clouds dialog box sele ct File > Detach . 

 
˷̘̦̣̖̚ ˪ ˨Ь ˵ ̖̥̙̒̔ ́ ̠̟̥̚ ˴̝̠̦̕ 

7. The same method  in 5.1.3 ˴̣̖̥̖̒ ˴̡̡̝̖̚̕ ̖̣̣̟̅̒̚ ˾̠̖̝̕ can be used to clip.  

 
˷̘̦̣̖̚ ˪  ˩Ь ˴ ̣̖̥̖̒ ̖̣̣̟̅̒̚ ̗̣̠̞ ̠̟̥́̚ ˴̝̠̦̕ ̝̠̘̒̕̚ ̠̩̓ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˨
 

˦˟ˤ ̖̣̣̟̅̒̚ ̗̣̠̞ ˶̄̃˺ 

This option is only available to users with a certain ESRI license.  

1. In CAD create  Share / Oxford / HW_CB_1234_1234 _ Oxford_TerrainFromEsri.dgn  

2. Turn on the View Background Map. Place a shape around the required LiDAR Data area.  

3. ˺̟ ̥̙̖ ˵˸˿ ̗̝̖̚Я̤ ̤̖̣̙̒̔ ̗̖̝̚̕ ̡̥̪̖ ̟̚ Esri  Terrain , Sign in to  ersi.  

4. A dialog box will appear, select the Feature Definition  Terrain \ Existing Ground.  

 
˷̘̦̣̖̚ ˪  ˪˞ ̄ ̖̥ ̥̙̖ ˶̩̤̥̟̘̚̚ ˸̣̠̦̟̕ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚ 

6. Follow the prompts and select the shape placed in step 3.  

7. Use the Element Selection Tool and select the new Terrain  outer boundary.  

8. In the  Properties  Box, Calculated Features Display  turn on the  Major Contours and Minor 
Contours.  



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˩
 

Exercise 6  Ь Terrains  for Drainage Analysis  
̙̅̚ ̤̖ ̩̖̣̤̖̔̚ ̨̝̝̚ ̧̠̖̣̔ ̕ ̗̗̖̣̖̟̥̚ ̢̥̖̙̟̦̖̤̔̚ ̨̙̖̟ ˴̣̖̥̟̘̒̚ ̟̒̕ ˾̟̘̟̘̒̒̚ ˾̡̦̝̥̝̖̚ ̖̣̣̟̅̒̚ ˾̠̖̝̤̕ 
̥̙̥̒ ̟̔̒ ̖̓ ̦̤̖̕ ̥̠ ̟̝̪̫̖̒̒ ˵̣̟̘̖̒̒̚ ˲̣̖̤̒˟ ̙̖̟̈ ̣̖̥̟̘̔̒̚ ̒ ̣̟̘̖̒̒̕̚ ̖̤̘̟̕̚ ̥̙̖ ̨̟̖̥̠̣̜ ̠̗ 
̟̝̖̥̤̚˝ ̡̚ ̡̖̤˝ ̟̒ ̕ ̠̔ ̟̥̣̦̥̟̘̓̚̚ ̠ ̧̖̣̝̟̒̕ ̨̗̝̠ ̨̝̝̚ ̡̖̩̟̒̕ ̠̦̥̤̖̚̕ ̠̗ ̥̙̖ ̡̡̣̠̠̤̖̕ ̥ ̖̣̣̟̤̒̚ ̟̒̕ ̘̠ 
̖̪̠̟̓̕ ̥̙̖ ̧̤̦̣̖̪̖̕  ̒ ̣̖̒˟ ˳̖ ̦̤̖̔̒ ̠̗ ̥̙̤̚ ̪̠̦ ̨̝̝̚ ̟̖̖ ̥̕ ̠ ̞̖̣̘̖ ̡̞̦̝̥̝̖̚ ̥ ̖̣̣̟̤̒̚˟  

˧˟ˢ ˴̣ ̖̥̒ ̖̖̣̣̟̤̅̒̚ ̗̣̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̤̚ ̠̠̝̅ 
̠̅ ̣̖̥̖̔̒  ̒́ ̡̣̠̠̤̖̕ ̖̣̣̟̅̒̚˝ ̨̖ ̣̖̒ ̘̠̟̘̚ ̥̠ ̦̤̖ ̥̙̖ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ̞̖̥̙̠̕˟ ̙̖̅ ̣̖̤̠̟̒ ̗̠̣ 
̥̙̤̚ ̤̚ ̥̙̥̒ ̥̙̖̣̖ ̣̖̒ ̞̟̪̒ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̤̚̚̚˝ ˽̟̖̣̒̚ ˶̝̖̞̖̟̥̤˝ ̡̖̞̝̥̖̅̒ ˷̖̥̦̣̖̤̒ ̟̒̕ 
̡̖̞̝̥̖̅̒ ˾̖̤̙̖̤ ̤̥̠̣̖̕ ̨̥̙̟̚̚ ̥̙̖ ̡̣̠̠̤̖́̕ ˵̖̤̘̟̚ ˴̠̣̣̠̣̚̕˝ ̟̒ ̓̕ ̪ ̦̤̟̘̚ ˸̡̣̙̝̒̔̒̚ ̗̝̥̖̣̤̚ ̨̖ 
̟̔̒ ̖̩̥̣̥̒̔ ̥̙̖̞ ̧̣̖̝̥̖̝̪̒̚ ̖̤̝̪̒̚˟ 
̡̖̟̀˫ 

ORD -  з\ ˵̖̤̘̟̍̚˹ ̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕  
̠ ̣

̀˳˾ ˞ з̍ ˵̖̤̘̟̍̚˳ ̣̘̖̍̚̕˳ ̤̖̒̐˾̠̖̝̤̍̄̕ ˳̐ ˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕   

˧˟ˢ˟ˢ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ 

ˢ˟ ̖̗̖̣̖̟̖̃̔ ̥̙̖ ̖̣̣̪́ ˽̟̖̒ ˴̠̣̣̠̣̚̕ ˷̝̖̚˟  
з˵̖̤̘̟̍̚˹ ̨̘̙̪̤̒̍̚˳ ̤̖̒̐˾̠̖̝̤̍̕˹ ̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̒̐˴̠̣̣̠̣̚̕˟̘̟̕ 

˿̠̥̖˫ ̙̖̅ ̡̠̖̟̖̕ ̗̝̖̚ ̨̝̝̚ ̠̞̖̔ ̨̥̙̚ ̥̙̖ ˶̩̤̥̟̘̚̚ ̖̣̣̟̅̒̚ ̝̣̖̪̒̒̕ ̣̖̗̖̣̖̟̖̔̕ ̟̒̕ ̤̖̥ 
̧̥̖̒̔̚˟ 

ˣ ˟ ̀̃ ˵˞ ̄ ̖̝̖̥̔ ̥̙̖ ̡̖̟̠̤̀̃̒̕ ̈ ̨̠̣̜̗̝̠˝ ̟̚ ̥̙̖ ̖̣̣̟̅̒̚ ̥̒̓̋ ˴̣̖̥̖̒ ̤̖̥̠̟̔̚˝ ̤̖ ̝̖̥̔ ˷̣̠̞ 
˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˯ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ 

 
˷̘̦̣̖̚ ˢˡ lЬ ̀ ̃˵ ˸̣ ̡̙̝̒̔̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ ̠̠̝̅ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˧  ˪
 

̀˳  ˾˞ ̄ ̖̝̖̥̔ ̥̙̖ ̡̖̟̀˳̣̘̖̚̕ ˾̠̖̝̖̣̕ ̨̠̣̜̗̝̠̈˝ ̟̚ ̥̙̖ ˴̧̝̚̚ ̥̒̓˝ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ̤ ̖̥̠̟̔̚˝ 
̤̖̝̖̥̔ ̥̙̖ ̡̥̠ ̝̖̗̥ ̡̦̝̝ ̨̠̟̕ ̟̒̕ ̙̠̠̤̖̔ ˴̣̖̥̖̒ ̖̣̣̟̅̒̚ ̞̠̖̝̕ ̪̓ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ̋̒  
̝̠̘̒̕̚ ̠̩̓ ̨̝̝̚ ̡̠̖̟ ̤̖ ̝̖̥̔ ̥ ̙ ̖̖̣̣̟̅̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ ̦̥̥̠̟̓ ˟

 
˷̘̦̣̖̚ ˢˡˢ˞ ̀ ˳˾ ˸̣ ̡̙̝̒̔̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ ̠̠̝̅ 

̙̖̅ ̖̣̣̟̅̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ ̝̠̘̒̕̚ ̡̡̖̣̤̒̒ ˫
¶ ̤̖̣̤̆ ̟̔̒ ̣̖̥̖̔̒ ̥̙̖̣̚ ̨̠̟ ̗̝̥̖̣̤̚ ̪̓ ̤̖̝̖̥̟̘̔̚ ˷̝̥̖̣̤̚ ̦ ̟̖̣̕ ̥̙̖ ̦̣̣̖̟̥̔ ˵˸˿˝ 
з̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕ ˟

¶ ̟̀ ̥̙̖ ̝̖̗̥˞̙ ̟̒ ̡̕ ̟̖̒ ̦̟̖̣̕ ˴̇̐˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̤̚˟̘̟̝̓̕̚˙˵̖̗̦̝̥̒˚ ̪̠̦ ̧̙̖̒ ̒ 
̤̖̣̖̤̚ ̠̗ ̡̣̖̖̗̟̖̕̚̕ ˷̝̥̖̣̚ ̡̘̣̠̦̤˝ ̥̙̥̒ ̣̖̒ ̘̣̪̖̒̕˟  ̙̖̤̖̅ ̣̖̒ ̧̖̝̖̣̖̕̚̕ ̨̥̙̚ ̥̙̖ 
˴̅˵̀̅ ̡̠̣̜̤̖̈̒̔ ̟̒̕ ̖̓ ̓ ̖ ̦̤̖̕ ̪̓ ̡̠̪̟̘̔̚ ̥̙̖̞ ̥̠ ̪̠̦̣ ˵˸˿ ̗̝̖̚˟ 

ˤ ˟ ˴̝̜̔̚ ̠̟ ̥ ̙ ̡̖̣̠̠̤̖́̕ ˷̟̤̙̚̚ ̘̣̖̒̕ ˷̝̥̖̣̚ ˸̡̣̠̦ ̦̟̖̣̕ ˴̇̐˸̡̣̙̝̗̝̥̖̣̤̒̔̒̐̚̚˟̘̟̝̓̕̚ ̒ ̟̕ 
̧̨̖̚ ̥̖̤̥ ̥̙̖̞ ̘̟̤̥̒̒̚ ̪̠̦̣ ̗̝̖̚˟  

 
˷̘̦̣̖̚ ˢˡˣ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  l
 

˥ ˟ ˿̠̥̖̔̚ ̧̖̖̣̪̥̙̟̘̚ ̙̘̙̝̘̙̥̤̚̚ ̡̖̩̖̥̔ ̗̠̣ ̥̙̖ ̖̞̄̒ ̝̟̖̚˟ 
˿̠̥̖˫ ̥̙̖ ̤̖̞̤̒ ̗̠̣ ̥̙̖ ̤̖̚̕ ̣̠̒̕ ̨̖̣̖ ̣̖̥̖̔̒̕ ̨̥̙̚ ˸̖̠̞̖̥̣̪ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚ ˾̤̔̚ 
˽̟̖̚ ̨ ̙̙̔̚ ̤̚ ̟̠̥ ̡̣̥̒ ̠̗ ̥̙̖ ̧̖̝̖̣̖̕̚̕ ˷̝̥̖̣̤̚˟  ̙̖̅ ̧̖̝̖̣̖̕̚̕ ̗̝̥̖̣̚ ̟̝̦̖̤̔̚̕ ̥̙̖ ˷̖̥̦̣̖̒ 
˵̖̗̟̥̠̟̚̚̚ ̖̞̄̒ ˽̟̖̤̚˝ ̥ ̙̤̚ ̤̚ ̥̙̖ ̗̖̥̦̣̖̒ ˵̖̗̟̥̠̟̤̚̚̚ ̥̙̥̒ ̤̙̠̦̝̕ ̖̓ ̗̠̣ ̡̛̣̠̖̥̤̔˟  ˺̟ ̥̙̤̚ 
̤̖̔̒ ̨̖ ̨̟̥̖̒̕ ̥̠ ̖̞̠̟̤̥̣̥̖̒̕ ̨̙̠ ̥̠ ̒̕̕ ̪̠̦̣ ̨̠̟ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚ ̥̠ ̒ ̗̝̥̖̣̚˝ ̤̠ 
˾̤̔̚ ˽̟̖̚ ̨̤̒ ̦̤̖̕ ˟

 
˷̘̦̣̖̚ ˢˡˤ 

˦ ˟ ˴̣ ̖̥̖̒ ̠̦̣ ̨̠̟ ̗̝̥̖̣̚˝ ̟̆ ̖̣̕ ˹̈̐˴˳̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚ ̣̚ ̘̙̥ ̝̜̔̔̚ ̠̟ ˷̝̥̖̣̤̚ 
̟̒̕ ̤̖̝̖̥̔ ˴̣̖̥̖̒ ˷̝̥̖̣̚ ˟

 
˷̘̦̣̖̚ ˢˡ˥ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨ s
 

˧ ˟ ˿̞̖̒ ̥̚ ̖̞̄̒ ˽̟̖̤̚ ˟

 
˷̘̦̣̖̚ ˢˡ˦ 

˨˟ ̖̝̖̥̄̔ ˶̥̕̚ ˷̝̥̖̣̚ 

 
˷̘̦̣̖̚ ˢˡ˧ 

˩ ˟ ̟̀ ̥̙̖ ˶̥̕̚ ˷̝̥̖̣̚ ̝̠̘̒̕̚ ̠̩̓ ̤̖̝̖̥̔ ˴̧̝̚̚ ˷̖̥̦̣̖̤̒˝ ̦̟̖̣̕ ˷̖̥̦̣̖̤̒ ̤̖̝̖̥̔ ˽̟̖̣̒̍̃̚ ̨̠̪̒̒̕ 
˸̖̠̞̖̥̣̪̍˾ ̤̔̚ ˽̟̖̚ ̟̒̕ ̝̜̔̔̚ ˲ ̕̕˟ 

 
˷̘̦̣̖̚ ˢˡ˨ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  x
 

˨˟ ˿̠̥̖̔̚ ̥ ̙̖ ˷̖̥̦̣̖̒ ˵ ̖̗̟̥̠̟̚̚̚ ̚ ̤ ̟̠ ̨̚ ̟ ̥̙̖ ̣̘̙̥̚˞̙ ̟̒ ̔̕ ̠̝̦̞̟ ˟˴ ̝̜̔̚ ˷̟̤̙̚̚ ˟

 
˷̘̦̣̖̚ ˢˡ˩ 

˩ ˟ ̥̙̈̚ ̖̞̄̒ ˽̟̖̚ ̤̤ ̖̝̖̥̖̔̕ ̋̔ ̝̜̔̚ ̠̟ ˽̟̜̚ ̥̠ ̖̣̣̟̅̒̚ ˷̖̥̦̣̖̤̒ ˟

 
˷̘̦̣̖̚ ˢˡ ˪Ь ˽ ̟̜̚ ̥ ̠ ̖̣̣̟̅̒̚ ˷̖̥̦̣̖̤̒ 

˪ ˟ ̘̙̥̃̚ ̝̔ ̜̔̚ ̠̟ ̥̙̖ ˴̝̜̔̚ ̠̟ ̥̙̖ ̡̣̠̠̤̖́̕ ˷̟̤̙̚̚ ̘̣̖̒̕ ˷̝̥̖̣̚ ˸̡̣̠̦ ̦̟̖̣̕ 
˴̇̐˸̡̣̙̝̗̝̥̖̣̤̒̔̒̐̚̚˟̘̟̝̓̕̚ ̒ ̟̕ ̖̝̤ ̖̥̔ ˴̡̠̪˟  

ˢˡ˟ ̖̝̖̥̄̔ ˷̝̥̖̣̚ ˸ ̡̣̠̦̤ ̗̠̝̖̣̕ ̠̟ ̡̥̠ ̟̒̕ ̤̖̝̖̥̔ ̤̥̖́̒ ˟̅ ̙̤̚ ̨̝̝̚ ̡̠̪̔ ̥̙̖ ˷̚ ̝̥̖̣̤ ̟̒̕ ̥̙̖ ̃̚ ̝̥̖̣ 
˸̣ ̡̠̦̤ ̥̠ ̪̠̦̣ ̘̟̕ ̗̝̖̚˟ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ʕ
 

 
˷̘̦̣̖̚ ˢˢ lЬ ˴ ̡̠̪ ˠ ̤̥̖́̒ ˷̝̥̖̣̤̚ 

˥ ˟ ˲̕̕ ̖̞̄̒ ˽̟̖̤̚ ̥ ̠ ̥̙̖ ˷̝̥̖̣̚ ˸̡̣̠̦˝ ̖̝̖̥̄̔ ˴̡̠̪ ̠̗ ̡̣̠̠̤̖́̕ ˷̟̤̙̖̚̚̕ ˸̣̖̒̕ ̠̋ ̟ ̥̙̖ ̣̘̙̥̚ 
̡̦̝̝ ̨̠̟̕ ̖̝̖̥̄̔ ˷̝̥̖̣̤̚ ̟̒̕ ̙̖̜̔̔ ̠̗̗ ̖̞̄̒ ˽̟̖̤̚ ˟˲  ̥̠̥̝̒ ̠̗ ˥ ̤̙̠̦̝̕ ̨̟̠ ̖̓ ̤̖̝̖̥̖̔̕˟ 

 
˷̘̦̣̖̚ ˢˢˢ ˞ ˶ ̥̕̚ ˷̝̥̖̣̚ ̝̠̘̒̕̚ ̠̩̓ ˲ ̕̕ ˷̝̥̖̣̤̚ ̥̠ ̒ ˸̡̣̠̦ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ˥
 

ˢ˥˟ ̟̀ ̥̙̖ ̖̣̣̟̅̒̚ ˷̝̥̖̣̚ ˾̟̘̖̣̒̒ ̝̠̘̒̕̚ ̤̖ ̝̖̥̔ ˷̟̤̙̚̚ ˟

 
˷̘̦̣̖̚ ˢˢ xЬ ˷ ̟̤̙̚̚ ˶̥̕̚ ˷̝̥̖̣̚ ̝̠̘̒̕̚ ̠̩̓ ˲ ̕̕ ˷̝̥̖̣̤̚ ̥̠ ̒ ˸̡̣̠̦ 

   
 
 
 
 
 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ˦
 

˧˟ˢ˟ˣ ˴̣̖̥̖̒ ̖̣̣̟̅̒̚ ̗ ̣̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ 

ˢ˟ ˿̨̠ ̨̖ ̨̝̝̚ ̣̖̥̖̔̒ ̥ ̙̖ ̥̖̣̣̟̒̚ 

̀̃˵ ˞ ̖̝̖̥̄̔ ̖̣̣̟̅̒̚ ˯ ˴̣̖̥̖̒ ˯ ˷̣̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˯ ˷̣̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ 

 
˷̘̦̣̖̚ ˢˢ ʕЬ ̀ ̃˵ ˷̣ ̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ̠̠̝̅ 

̀˳˾ ˞ ̖̝̖̥̄̔ ̥̙̖ ̡̖̟̀˳̣̘̖̚̕ ˾̠̖̝̖̣̕ ̨̠̣̜̗̝̠̈˝ ̟̚ ̥̙̖ ˴̧̝̚̚ ̥̒̓˝ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 
̤̖̥̠̟̔̚˝ ̤̖̝̖̥̔ ̥̙̖ ̡̥̠ ̝̖̗̥ ̡̦̝̝ ̨̠̟̕ ̟̒̕ ̙̠̠̤̖̔ ˴̣̖̥̖̒ ̖̣̣̟̅̒̚ ̞̠̖̝̕ ̪̓ ˸̡̣̙̝̒̔̒̚ 
˷̝̥̖̣̚ 

 
˷̘̦̣̖̚ ˢˢ ˥˞ ̀ ˳˾ ˷̣ ̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ̠̠̝̅ 

ˣ ˟ ̙̖̅ ˴̣̖̥̖̒ ̖̣̣̟̅̒̚ ̗̣̠̞ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ̝̠̘̒̕̚ ̨̝̝̚ ̡̡̖̣̒̒˟ 
¶ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚˫ ̖̣̣̟̅̒̍̚˵ ̖̤̘̟̚ ̠̅ ̡

¶ ˿̞̖̒˫ ́̐̅˶̖̣̣̪̃̃̐́˽̟̖̒ 

¶ ˲̡̡̖̟̕ ̥̠ ̖̣̣̟̅̒̚ ˫̀˷ ˷

¶ ̟̀ ̥̙̖ ̖̝̖̥̄̔ ˷̝̥̖̣̚ ̠̣ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˸̡̣̠̦ ˫˽̖̗̥ 
˴̝̜̔̚ ̠̟ ̥̙̖ ̡̖̝̝̤̖̤̚ ̦̥̥̠̟̓ ̠ ̟ ̥̙̖ ˸̡̣̙̝̒̔̒̚ ̗̝̥̖̣̚ 
̝̠̘̒̕̚ ̠̩̓ 

¶ ˸̠ ̥̠з ˲̧̥̖̔̚ ˵˸˿ ˯ ˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ ˸̡̣̠̦̤ ˯ 
˴̡̠̪ ̠̗ ̡̣̠̠̤̖́̕ ˷̟̤̙̖̚̚̕ ˸̣̖̒̕ 

¶ ˺̘̟̠̣̖ ˷̖̥̦̣̖̒ ˽̟̜̟̘̚̚˫ ̀˷ ˷

¶ ̖̥̄ ˶̘̖̕ ˾̖̥̙̠̕ ˫̧̖̞̠̖̃ ̧̝̖̣̤̄̚ 

¶ ̖̝̖̥̄̔ ̧̨̣̖̖́̚ ̥ ̠ ̤̖̖ ̨̙̥̒ ̤̚ ̖̟̘̓̚ ̗̝̥̖̣̖̚̕ ̟̚˟ 

ˤ ˟ ˵̥̒̒ ̠̟̥́̚ ̥ ̠ ̡̖̥̒̔̔ ̤̖̝̖̥̠̟̔̚˟ 

˥ ˟ ˽̖̗̥˞̔ ̝̜̔̚ ̥̠ ̡̖̥̒̔̔ ̥̙̖ ̡̣̞̖̥̖̣̤̒̒˟ ̠̦̣̊ ̡̣̠̠̤̖́̕ ̖̣̣̟̅̒̚ ̨̝̝̚ ̖̓ ̣̖̥̖̔̒̕ ˟

˦ ˟ ˹̥̚ ˭˶̤̔˯ ̥ ̠ ˶̩̥̚ ˴̠̞̞̟̒̕ ˟

˷̘̦̣̖̚ ˢˢ ˦˞ ˴ ̣̖̥̖̒ ̖̣̣̟̅̒̚ ˷̣̠̞ 
˸̡̣̙̝̒̔̒̚ ˷̝̥̖̣̚ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ˧
 

˧ ˟ ˺̟ ˶̡̩̝̠̣̖̣ ̤̖̝̖̥̔ ̖̣̣̟̅̒̚ ˾̠̖̝̤̕ ˯ ˵̖̤̘̟̚ ̡̠̅˝ ̟̒̕ ̦̣̟̅ ̠̟ ̥̙̖ ̣̟̘̝̖̤̅̒̚˟  ̨̖̇̚ ̥̙̖ 
̥̖̣̣̟̒̚ ̥̙̥̒ ̨̤̒ ̛̦̤̥ ̣̖̥̖̔̒̕˟ 

 
˷̘̦̣̖̚ ˢˢ˧ 

 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ˨
 

˧˟ˣ ˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ 
˺̟ ̥̙̤̚ ̤̖̥̠̟̔̚ ̪̠̦ ̨̝̝̚ ̝̖̣̟̒ ̨̙̠ ̥̠ ̣̖̥̖̔̒ ̒ ˴̡̠̞̝̖̩ ̥̖̣̣̟̒̚˟ 
1. Open  

ORD File  зDesign \ Share \ HW_ NC_1234_1234_Oxford _ DrainageComplexTerrain.dgn  
or  

OBM File  зDesign \ Share \ SB_ NC_1234_1234_Oxford _ DrainageComplexTerrain.dgn  

2. Select the Reference tool  

Browse to attach : Active_Survey \ SV_XX_0107_0108_Oxford_ORD_Terrain.dgn  

Attachment Method is set to Interactive  and  Save Relative Path is on . Select Open . 

On the Reference Attachment Properties select:  
Model: Default  
Orientation:  Coincident World  
Detail Scale:  s вˮ˥ˡЯ    
Nested Attachments: No Nesting  

ˣ ˟ ̞̝̣̝̪̄̒̚̚ ̥̥̙̒̒̔ ˫
˹̨̘̙̪̒̍̚˹̈̐˴ ́̐ˢˣˤ˥̐ˢˣˤ˥̠̦̥̖̐̃ˢ˩˩̐̅ ̖̣̣̟̒̚˟̘̟̕ 

Model: 3D Design  

˹̨̘̙̪̒̍̚˹ ̈̐˴́̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̒̐ ̖̣̣̟̅̒̚˟̘̕ ̟̠  ̣
˳̣̘̖̍̄̚̕˳̐ ˴́̐ˢˣˤ˥̐ˢˣˤ˥̖̣̣̪̐́˽̟̖̖̣̣̟̒̐̅̒̚˟̘̟̕ 

Model: 3D Design  

ˣ ˟ ̖̝̖̥̄̔ ̥̙̖ ̖̗̖̣̖̟̖̃̔ ̥̠̠̝˟  ˳̨̣̠̤̖ ̥̠ ̥̥̙̒̒̔ ̥̙̖ ̗̝̖̚ ̪̠̦ ̣̖̥̖̔̒̕ ̟̚ ˦˟ˢ˟ˢ 

Share \ ..._ NC_1234_1234 _Oxford_TerrainFromLAS.dgn   

Select Geographic Ь reprojected  and c lick  Open .  

 
˷̘̦̣̖̚ ˢˢ ˨˞ ˲ ̥̥̙̒̔ ̖̗̖̣̖̟̖̃̔ 



̇̀˽̆˾˶  x˞ ̈ ̠̣̜̟̘̚ ̨̥̙̚ ˶̩̤̥̟̘̚̚ ˵̥̒̒ 

˨  ˩
 

3. Notice the reference lines up with the NAD 27 Survey File.  

 
˷̘̦̣̖̚ ˢˢ ˩˞ ̃ ̖̗̖̣̖̟̖̤̔ ̟̚ ̨̖̇̚ 

ˤ ˟ ˺̟ ̥̙̖ ̡̣̠̖̣̥̖̤́̚ ̝̠̘̒̕̚ ̠̩̓˝ ̧̠̖̣̣̖̚̕ ̥̙̖ ̣̖̗̖̣̖̟̖̔̕ ̥̖̣̣̟̤̒̚ ̤̒ ̨̗̠̝̝̠̤˫ 

̖̥̄ ̧̖̣̣̖̀̚̕ ̪̞̠̝̠̘̪̄̓ ˫ ̖̊  ̤
̧̖̣̀ ̡̖̞̝̥̖̅̒˫ 
¶ ˴̡̡̝̖̚̕˫ ̖̅ ̣̣̟̒̍̚˶ ̩̤̥̟̘̚̚ ˸̣̠̦̟̕ 
¶ ̦̣̗̖̄̇̐̄̒̔˫ ̖̅ ̣̣̟̒̍̚˶ ̩̤̥̟̘̚̚ ˸̣̠̦̟̕ 
¶ ́̐ ̅˶̠̦̥̖̃̃̐̃ˢ˩˩˫ ̖̅ ̣̣̟̒̍̚˵ ̖̤̘̟̚ ̡̠̅ 
¶ ́̐̅˶̖̣̣̪̃̃̐́˽̟̖̒˫ ̖̅ ̣̣̟̒̍̚˵ ̖̤̘̟̚ ̡̠̅ 

 
˷̘̦̣̖̚ ˢˢ ˪Ь ̅ ̖̣̣̟̒̚ ̧̖̣̣̖̤̀̚̕ 
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˨  ˪
 

˥ ˟ ˴̣̖̥̖̒ ̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕˟ ˺ ̟ ̖̣̙̄̒̔ ̡̥̪̖ ̟̚ ˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕˝ ̥̙̖ 
˴̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ̝̠̘̒̕̚ ̨̝̝̚ ̡̡̖̣̒̒˝ ̥̙̤̚ ̥ ̠̠̝ ̨̝̝̚ ̣̖̒̕ ̝̒ ̝̥ ̙̖ ̥̖̣̣̟̒̚ ̤̒ ̥̥̙̖̒̔̕ 
̤̒ ̙̘̙̝̘̙̥̖̚̚̕ ̨̖̝̠̓ Ь 

˦ ˟ ̖̝̖̥̄̔ ˴̦̣̣̖̟̥ ˲̥̠̟̔̚˫ ˾̖̣̘̖˝  ˽̖̗̥˞̔ ̝̜̔̚ ̠ ̟ ̖̅ ̣̣̟̤̒̚ ̟̚ 
̥̙̖ ̨̗̠̝̝̠̟̘̚ ̠̣̖̣̕ ̒ ̟̕ ̝̜̔̔̚ ˲̕̕˫ 
¶ ˴̡̡̝̖̚̕ 
¶ ̦̣̗̖̄̇̐̄̒̔ 
¶ ́̐̅˶̠̦̥̖̃̃̐̃ˢ˩˩ 
¶ ́̐̅˶̖̣̣̪̃̃̐́˽̟̖̒ 

ˢˡ˟ ̖̥̄ ̥̙̖ ̖̣̣̟̅̒̚ ˾̠̖̝̕ ̡̣̠̖̣̥̖̤́̚ ̤̒ ̨̤̙̠̟ ̨̖̝̠̓ 
¶ ˷̖̥̦̣̖̒ ˵̖̗̟̥̠̟̚̚̚˫ ̖̣̣̟̅̒̍̚˶ ̩̤̥̟̘̚̚ ˴̠̟̥̠̦̣̤ ̟̝̪̀ 
¶ ˿̞̖̒˫ ˵̣̟̘̖̒̒̚ ̖̣̣̟̅̒̚ 

˳̖̗̠̣̖ ̣̖̥̟̘̔̒̚ ̒ ̡̠̞̝̖̩̔ ̥̖̣̣̟̒̚˝ ̪̠̦̣ ̝̠̘̒̕̚ ̠̩̓ ̨̝̝̚ ̝̠̠̜ ̤̞̖̒ ̤̒ ̨̤̙̠̟ ̨̖̝̠̓ 

ˢˢ˟ ˽̖̗̥˞̔ ̝̜̔̚ ̠̟ ˷̟̤̙̚̚ ̓ ̦̥̥̠̟ ̥̒ ̥̙̖ ̖̟̕˟ 

 
˷̘̦̣̖̚ ˢˣ s˞ ˴ ̣̖̥̖̒ ˴̡̠̞̝̖̩ ̖̣̣̟̅̒̚ ˾̠̖̝̕ 

ˢˣ˟ ̠̠̞̋ ̟̚ ̥̠ ̤̖̖ ̥̙̖ ˾̖̣̘̖̕ ˴̡̠̞̝̖̩̖̕ ̖̣̣̟̅̒̚˟ ̅ ̦̣̟ ̠̗̗ ̥̙̖ ̖̗̖̣̖̟̖̃̔ ̗̝̖̤̚ ̥̠ ̖̥̥̖̣̓ ̤̖̖ ̥̙̖ 
˾̖̣̘̖̕ ̖̣̣̟̅̒̚˟ 

ˢˤ˟ ̙̤̅̚ ˾̖̣̘̖̕ ̖̣̣̟̅̒̚ ̤̚ ̨̟̠ ̣̖̪̒̕ ̥̠ ̖̓ ̣̖̗̖̣̖̟̖̔ ̕̚ ̟̥̠ ̪̠̦̣ ˵̣̟̘̖̒̒̚ ̠̣̜̟̘̈̚ ̗̝̖̚˟ 

˷̘̦̣̖̚ ˢˣ l˞ ˲ ̕̕ ̖̣̣̟̤̅̒̚ 
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˩  l
 

 
˷̘̦̣̖̚ ˢˣ xЬ ˾ ̖̣̘̖ ̖̣̣̟̅̒̚ 






































